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Abstract

Build-a-Table is a free online tool that allows users to find, download and customize tables of
data from the Census of Government Employment for 1997, 2002, and 2007. In January 2009,
the Statistical Research Division (SRD) evaluated the usability of the Build-a-Table Web site.
The testing evaluated the success and satisfaction of nine participants with the site developed by
the Public Employment and Payroll Build-a-Table team from the Governments (GOVYS)
Division. Participants attempted to complete eight pre-determined tasks, developed specifically
for this study, on the Web site. Usability testing revealed several usability problems including
unclear instructions, lack of clarity in how many items could be chosen to build a table, and
unclear functionality of the Main button. Overall, participants were satisfied with the Web site,
and pre-determined satisfaction and efficiency goals were met. This report provides a complete
summary of the findings of this usability evaluation. Recommendations are provided to improve
the usability of the Build-a-Table Web site.



Executive Summary

In January 2009, the Statistical Research Division (SRD) evaluated the usability of the Build-a-
Table Web site. The testing evaluated the success and satisfaction of nine participants with the
site developed by the Public Employment and Payroll Build-a-Table team from the Governments
(GOVS) Division. Participants attempted to complete eight pre-determined tasks, developed
specifically for this study, on the Web site. Testing took place at the US Census Bureau
Usability lab in Suitland, MD.

Purpose. The primary purpose of this usability testing was to identify elements of the user-
interface design that were problematic and led to ineffective, inefficient, and unsatisfying
experiences for people using the Web site.

Method. SRD recruited ten participants; nine were recruited externally through a database
maintained by the Usability Lab, and one Usability Lab intern, who had no previous exposure to
the Build-a-Table Web site, was recruited. One external participant’s data were removed from
the analysis due to inexperience navigating through the Internet, as observed during the usability
testing. The remaining nine participants were considered knowledgeable in navigating the
Internet and using a computer.

Each participant sat in a small room, facing one-way glass and a wall camera, in front of an LCD
monitor equipped with an eye-tracking machine. The participant and test administrator were not
in the same room. The sessions were audio and video recorded, and tracking of the participants’
eye movements were recorded during the usability tests.

While completing the eight tasks, participants were encouraged to think aloud and to share what
they were thinking about the tasks. If at any time the participant became quiet, the test
administrator reminded the participant to think aloud. The participant’s narrative allowed the
Usability Lab team to gain a greater understanding of how participants completed tasks and to
identify issues with the Web site. The test administrator noted any behaviors that indicated
confusion.

After completing all tasks, the participants completed a Satisfaction Questionnaire and then
answered debriefing questions. Overall, each usability session ran about 60 minutes.

Results. This report presents issues prioritized from high to low in terms of their effect on
participant performance and provides complete descriptions of each finding and
recommendations for usability issues. The usability issues deal primarily with lack of useful
guidance for the user and difficulty in locating certain pieces of information within the Web site.

The following section highlights high-priority issues and recommendations to resolve them.

1. Users did not understand that they could only choose one item on the main page. Most
participants, most of the time, tried to select more than one option on the main page. Often,
when users clicked on a different category, they did not realize the other category had been over-
ridden.



Recommendation: Make the statement “You must make one selection from one of the three
basic categories” more visible. Also, move the items closer together so that when an option is
de-selected, people can see that it has been de-selected.

2. Instructions were not clear, and ‘Next’” was below the fold. Users often did not know what
they were supposed to do to build a table. They were instructed to select which category they
would like to base their table on, but they were not instructed on what to do next. Users often
missed the Next button.

Recommendation: Move the Next button above the fold of the page. Add more instructions
that explicitly tell the user to select the Next button.

3. Users did not understand that they could choose more than one item on the variables page.
Often, users were able to complete tasks, but only after going back to the Main page and starting
over. Participants used the back button frequently, as well as the Back to Build-a-Table Main
and Start Over buttons.

Recommendation: Revise instructions in order to explicitly tell participants that they can
choose more than one selection from each category.

4. Users selected Main on the top navigation of the variable page expecting to go to Build-a-
Table Main. People expected to go back to the Build-a-Table main page when they clicked on
Main as this is the way that Web sites usually work. Users rely on norms, as they impart a sense
of familiarity that can be an important part of navigation (Krug, 2006). In this study, sometimes
participants selected Main and then navigated to the Build-a-Table main page from the
Governments main page (which is where Main navigated them to).

Recommendation: Change Main to “Census of Governments Main Page” and add “Build-a-
Table Main” to the top navigation.
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A Usability Evaluation of the Build-a-Table Web Site

1.0 Introduction

Build-a-Table is a free online tool that allows users to find, download and customize tables of
data from the Census of Government Employment for 1997, 2002 and 2007. Build-a-Table is
available to the public, and a multitude of diverse users use the tool. Following an expert review
of the site (Ashenfelter, Romano & Murphy, 2008), this usability study was planned to evaluate
the user interface of the Web site. This report specifies the methods and materials that the
Statistical Research Division (SRD) used in evaluating the usability of the Build-a-Table Web
site (http://harvester.census.gov/datadissem/). This report also documents the results of the
testing, recommendations made by the usability team and the design team’s responses to the
recommendations.

This usability testing evaluated the success and satisfaction of test participants with the Web site
developed by the Public Employment and Payroll Build-a-Table team from the Census Bureau’s
Governments (GOVS) Division. Participants attempted to complete tasks supported by the Web
site and developed specifically for the usability test. The three pages of the Web site that are
essential to building tables that are discussed in this report are the main page (step 1), the
variables page (step 2) and the table page (step 3, or the result). See Appendix C for screen shots
of each page. Findings and recommendations are provided to inform the sponsor and the
designer(s) on areas of satisfaction as well as areas where the participants struggled while using
the Build-a-Table Web site.

1.1 Background

The user interface is an important element to the design of a Web site. For a Web site to be
successful, the interface must be able to meet the needs of its user in an efficient, effective, and
satisfying way. The present study examines the user interface of the Build-a-Table Web site.
The design of the Web site must support the users’ attempts to find target information, that is, the
user should experience success in navigating through the interface. Success is defined as
accuracy and timeliness in finding the appropriate information. The overall experience of using
the site should be satisfying for users.

An expert review was conducted in October 2008 (Ashenfelter, Romano & Murphy, 2008). A
screen shot of the Web site prior to the 2008 expert review and a checklist of high-priority
recommendations from the review are included in Appendix A and Appendix B, respectively.
The design team made changes to the Web site, based on recommendations from the expert
review. Screen shots of the revised site that was tested in this usability study can be found in

Appendix C.

Nine participants participated in usability testing between January 6 and January 16, 2009. A
brief report of major findings and recommendations was prepared for and disseminated to the
client on February 3, 2009. Members of SRD’s Usability Lab met with members of the Public
Employment and Payroll Build-a-Table team on February 18, 2009 to discuss findings and
recommendations. Responses from the Public Employment and Payroll Build-a-Table team to
the recommendations provided by SRD are included in this report following each finding. See
Appendix C for screen shots of the tested version and Appendix D for screen shots of the revised



version, which includes changes based on SRD’s findings and recommendations from the
January 2009 testing.

1.2 Purpose

The primary purpose of this usability testing was to identify elements of the user-interface design
that were problematic and led to ineffective, inefficient and unsatisfying experiences for people
using the Web site.

1.3 Usability Goals

Prior to usability testing, the sponsor and the Usability Lab team set usability goals for the study.
The goals were defined in three categories: user accuracy, efficiency and satisfaction. In this
study, these goals reflect the extent to which the user interface was expected to support user
performance and satisfaction.

Goal 1: To achieve a high level of accuracy in completing the given tasks using the Build-a-
Table Web site. The user should be able to successfully complete 75 percent of the given tasks.

Goal 2: To achieve a high level of efficiency in using the Build-a-Table Web site. The user
should be able to complete the tasks in an efficient manner taking four minutes or less to
complete each task.

Goal 3: To experience a moderate to high level of satisfaction from using the Build-a-Table
Web site. The overall mean of the Satisfaction Questionnaire ratings should be well above the
mid-point (5 on a nine-point scale, where 1 is the lowest rating and 9 is the highest rating). The
same should be true for the individual Satisfaction Questionnaire items.

1.4 Scope

All user interactions with the Build-a-Table Web site are within the scope of the usability
evaluation. The version of the Web site that was tested is the updated version, following the
October 2008 expert review. The user interface design was not tested for compliance with the
Section 508 regulations. However, because this is a government Web site, it must comply with
Section 508 regulations unless a waiver is granted.

1.5 Assumptions

e Participants were external, non-federal employees who were recruited via the SRD
Usability Lab database.

Participants had at least one year of prior Internet and computer experience.
Participants had prior knowledge of how to navigate a Web site.

Participants did not have extensive prior experience using the Build-a-Table Web site.
Participants had no known disabilities.

2.0 Method

2.1 Participants and Observers

SRD recruited nine participants externally through a database maintained by the Usability Lab;
one Usability Lab intern, who had no previous exposure to the Build-a-Table Web site, was also
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recruited. One external participant’s data were removed from the analysis due to inexperience

navigating through the Internet, as observed during the usability testing. The remaining
participants were considered knowledgeable in navigating the Internet and using a computer.

Observers from the Public Employment and Payroll Build-a-Table team were invited to watch

the usability tests on television screens in a room separate from the participant and test
administrator. Prior to beginning the tasks, the participants were briefly informed about the
purpose of the study and the uses of data that were to be collected. At the end of each test
session, the test administrator and observers discussed the findings from that session and

compared them to findings from other sessions. See Table 1 for participant demographics and

Table 2 for participants’ self-reported computer and Internet experience.

Table 1. Participant Demographics

Gender Age Education
Male 4 <30 5 HS, GED 1
Female 5 31-45 2 Some college, AA 1
46-60 2 Bachelor’s 4
Master’s + 3

Mean = 35.22 years'

Mean = 16.11 years®

Table 2. Participants’ Self-Reported Computer and Internet Experience

Scale: 1 (no experience) —
9 (very experienced) Scale: 1 (not comfortable) — 5 (comfortable) Scale: 1 (never) — 5 (very often)
How often How often
How often | working with using the
Overall Comfort in Comfort in working complex Internet or
Hours per experience Overall learning to Comfort in using and with data analyses of Web sites to
day on the with experience navigate new | manipulating a navigating througha | data through a find
Participant Internet computers with Internet Web sites window the Internet computer computer information
1 2 7 6 4 4 4 3 3 4
2 2 8 8 5 5 5 3 3 4
3 5 5 5 5 5 5 3 3 3
4 2 5 5 4 3 3 2 1 2
5) 7 8 9 5 5 5 5 4 5
6 5 7 8 5 5 5 5 4 5
7 7 6 7 3 5 5 3 1 5
8 (intern) 5 8 7 4 5 4 5 3 4
9 5 7 7 4 4 4 5 4 4
Average
across
participants 4.44 6.78 6.89 4.33 4.56 4.44 3.78 2.89 4.00

! The mean age was calculated from the exact values for each participant. The exact self-reported values were

places in ranges in Table 1 to help the reader get an overview of the data.

% The mean years of education was calculated from the exact values of “years of formal education” for each
participant. The self-reported values were placed in ranges to help the reader get an overview of the data.
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2.2 Facilities and Equipment

Testing took place at the Usability Lab at the U.S. Census Bureau in Suitland, MD, Room
5K512.

2.2.1 Testing Facilities

The participant sat in a small room, facing one-way glass and a wall camera, in front of an LCD
monitor equipped with an eye-tracking machine that was on a table at standard desktop height.
The test participant and test administrator were not in the same room. During the usability test,
the test administrator sat in the control room on the other side of the one-way glass. The test
administrator and the test participant communicated via microphones and speakers.

2.2.2 Computing Environment

The participant’s workstation consisted of a Dell personal computer, a 17” Tobii LCD monitor
equipped with cameras for eye tracking, a standard keyboard, and a standard mouse with a
wheel. The operating system was Windows XP.

2.2.3 Audio and Video Recording

Video of the application on the test participant’s monitor was fed through a PC Video
Hyperconverter Gold Scan Converter, mixed in a picture-in-picture format with the camera
video, and recorded via a Sony DSR-20 digital Videocassette Recorder on 124-minute, Sony
PDV metal-evaporated digital videocassette tape. Audio for the videotape was picked-up from
one desk and one ceiling microphone near the test participant. The audio sources were mixed in
a Shure audio system, eliminating feedback, and fed to the videocassette recorder.

2.2.4 Eye Tracking

Using the ClearView 2.0 software program, the Tobii eye-tracking device monitored the
participant’s eye movements and recorded eye-gaze data. Data collected from the eye-tracking
device included eye gaze and eye fixations for areas of interest (AOIs). AOIls were defined prior
to the usability evaluation as areas that were of particular interest to the sponsor: (1) ‘Data are for
the month of March’ text, on the main page, (2) Examples | Definitions link, on the main page,
(3) Currently Selected, on the variables page, and (4) Census of Government Employment
information link on the table page. See Appendix C for exact locations of the AOls.

2.3 Materials

2.3.1 General Introduction

The test administrator read some background material and explained several key points about the
session. See Appendix E.

2.3.2 Consent Form
Prior to beginning the usability test, the participant completed a consent form. See Appendix F.

2.3.3 Questionnaire on Computer Use and Internet Experience

Prior to the usability test, the test participant completed a questionnaire on his or her computer
use and Internet experience. See Appendix G.
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2.3.4 Tasks and Task-based Goals

Members of the Public Employment and Payroll Build-a-Table team, as well as members of the
Usability Lab, created the tasks and the task-based goals. The tasks were designed to capture the
participant’s interaction with and reactions to the design and functionality of the Build-a-Table
Web site. See Appendix H.

2.3.5 Satisfaction Questionnaire

Members of the Usability Lab created the Satisfaction Questionnaire, loosely based on the
Questionnaire for User Interaction Satisfaction (QUIS, Chin, Diehl, and Norman, 1988). In
usability tests at the Census Bureau, typically 10 to 12 satisfaction items are used that are
tailored to the particular user interface being evaluated. In this study, the Satisfaction
Questionnaire included 10 items worded for the Build-a-Table Web site. See Appendix I.

2.3.6 Debriefing Questions

After completing all tasks, the participant answered debriefing questions about his/her
experience using the Build-a-Table Web site. See Appendix J.

2.4 Procedure

Following security procedures, each participant reported separately to the visitor’s entrance at U.
S. Census Headquarters and was escorted to the Usability Lab. Upon arriving, the participant
was seated in the testing room. The test administrator greeted the participant and read the
general introduction (Appendix E). Next, the participant read and signed the consent form
(Appendix F). After signing the consent form, the test participant completed the Questionnaire
on Computer Use and Internet Experience (Appendix G). During this time, the test administrator
placed the task questions and Satisfaction Questionnaire on the desk beside the participant and
left the testing room to do a sound check in the control room. Upon the participant’s completion
of the questionnaire, video recording began, and the participant’s eyes were calibrated.
Calibration consisted of the participant looking at a dot moving around the computer screen and
took approximately fifteen to twenty seconds. Once calibration was complete, the eye tracker
began recording data.

Following calibration, the participant completed the Build-a-Table Web site tasks. Task order
was varied so that no participant received the tasks in the same order. See Appendix K for the
orders of task presentation. At the start of each task, the participant read the task aloud. While
completing the tasks, the participants were encouraged to think aloud and to share what they
were thinking about the task. (They had practice thinking aloud during the initial introduction.)
The participant’s narrative allowed us to gain a greater understanding of how they completed the
task and to identify issues with the Web site. If at any time the participant became quiet, the test
administrator reminded the participant to think aloud, by using prompts, such as “What are you
thinking as you look at this page?” “Tell me about your thoughts,” and “What are you expecting
to see?” At the conclusion of each task, the participant stated their answer to the task aloud.
During the task, the test administrator noted any behaviors that indicated confusion, such as
hesitation, backtracking and frowning. After the participant completed all tasks, the eye-tracking
device was stopped, and the participant completed the Satisfaction Questionnaire.
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After the participant completed the Satisfaction Questionnaire, the test administrator returned to
the testing room where the participant answered the debriefing questions. This was an
opportunity for a conversational back and forth exchange during which the test administrator
remained neutral. At the conclusion of the debriefing, the video recording was stopped, and the
participant was compensated $40. Overall, each usability session lasted approximately 60
minutes.

2.5 Performance Measurement Methods

2.5.1 Accuracy

After each participant completed a task, the test administrator rated the task as a success or a
failure. In the context of usability testing, successful completion of a task means that the design
supported the user in reaching a goal. Failure means that the design did not support task
completion. A successful task involved the test participant successfully navigating the user
interface to identify the correct piece of information on the Web site based on the task objective.
If the participant struggled to find the information but eventually arrived at the correct response,
this was marked as a success. A failure was recorded when the user interface presented obstacles
to the participant’s attempts to reach the goal.

Average accuracy scores were calculated across all participants for each task and across all tasks
for each participant. Prior to the usability testing, the sponsor and the Usability Lab team set an
overall accuracy goal of 75 percent across the participants.

2.5.2 Efficiency

After all usability tests were complete, the test administrator calculated the average time taken to
complete each task. Average times were calculated across all participants for each task and
across all tasks for each participant. Prior to the usability testing, the sponsor and the Usability
Lab team set an efficiency goal of four minutes or less to complete each task. In addition, the
test administrator calculated the time elapsed before participants looked at each AOI. An
average across all participants was calculated for each of the four AQls.

2.5.3 Satisfaction

After completing the usability session, each participant indicated his/her satisfaction with the
Web site using the tailored ten-item Satisfaction Questionnaire. For example, participants were
asked to rate their overall reaction to the site by circling a number from 1 to 9, with 1 being the
lowest possible rating and 9 the highest possible rating. Ranges and means were calculated for
the various attributes of the Web site, based on participant ratings. Prior to the usability testing,
the sponsor and the Usability Lab team set a satisfaction goal of an average mean well above the
mid point of the 9-point scale.

2.5.4 Eye-Tracking Data

Eye tracking captures exactly where people look as they navigate through a Web site. The eye-
tracking data allow us to look at an individual’s pathway through a site as well as accumulate
data and show the common pathways through a Web site. Eye-tracking measures include
fixations, gazes, scanpaths and hot spots. A fixation is an instant where the eyes are relatively
still. Fixations last 218 milliseconds, on average (Poole & Ball, 2005). Although the meaning of
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differing lengths of fixations is a matter of discussion among experts, there is some evidence for
the following interpretations (Poole & Ball, 2005). During an encoding task, such as looking at a
Web page, higher fixations indicate an area of interest and/or that the target may be complex and
difficult to understand. During a search task, higher fixations indicate greater uncertainty in
identifying the target object and/or the length of fixation indicates cognitive demand. For the
purposes of this usability test, the tasks fall into both the encoding and search categories. The
analysis of high number of fixations will be specific to the given task.

A gaze is the total number of fixations in a given area across all subjects. Gazes indicate which
areas are getting the most attention (Poole & Ball, 2005). In this study, we were able to see the
exact gazes of the individual participants, as well as a mean across all participants. In this report,
we identify gazes for predetermined AOls.

A hot spot is an area of the screen where people spend a few moments looking. Hot spots can be
examined individually or can be collapsed across participants into a heat map for an image that
displays the average of all hot spots for all the participants together. Heat maps range in color
from green (short amount of time fixating) to red (long amount of time fixating). In this report,
we examined predefined AOIs and determined whether these areas were hot spots.

2.5.5 Identifying and Prioritizing Usability Problems

To identify design elements that caused participants to have problems completing the task
objectives, the test administrator recorded detailed notes during the usability sessions. To
reinforce these notes, the test administrator used the videotape recordings to refresh her memory
and to confirm/disconfirm findings. By noting participant behavior and comments, the test
administrator, in cooperation with additional Usability Lab members, inferred the likely design
element that caused the participants to experience difficulties. The usability issues were grouped
into categories based on priority. The findings and recommendations of these issues are
presented below.

The usability team assigned each problem a priority code, based on its effect on performance, as
follows:

e High Priority — These problems bring the test participant to a standstill. He or she is not
able to complete the task.

e Medium Priority — These problems cause some difficulty or confusion, but the test
participant is able to complete the task.

e Low Priority — These problems cause minor annoyances but do not interfere with the
flow of the tasks.

3.0 Results, Recommendations and Team Responses

Results from the usability study are discussed below. The quantitative data, usability issues, and
eye-tracking data are presented, and the team responses to the recommendations round out the
documentation of each result. See Appendix L for raw navigation data, eye-tracking data and
participant comments.
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3.1 Participant Accuracy

The overall accuracy score was 64 percent. Accuracy scores ranged from 13 percent to 100
percent across users and from 22 percent to 100 percent across tasks. Although some questions
included wording that provided hints to users, the accuracy scores were still not in line with the
75 percent accuracy goal. It appears that participants struggled the most with tasks 1, 2, 6, 7 and
8. See Table 3 for user accuracy scores and Appendix H for the complete tasks.

Table 3. User Accuracy Scores

Task
2A Scces
Participant 1 2%* (Total) 3 4 5 6 7 8 rate
1 Success Failure Failure Success Success Success Failure Failure Success 63%
2 Failure Failure Success Success Success Success Success Failure Failure 63%
3 Failure Failure Failure Failure Failure Success Failure Failure Failure 13%
4 Failure Failure Failure Success Success Success Failure Failure Success 50%
5 Failure Failure Failure Success Failure Success Failure Failure Success 38%
6 Success Failure Success Success Success Success Success*** Success*** Success  100%
7 Success Failure Success Success Success Success Success* Failure Success 88%
8 (intern) Success Failure Success Success Success Success Success* Failure Success 88%
9 Success Failure Success Success Success Success Failure Success Failure 75%
Success by
task 56% 56% 89% 78% 100% 44% 22% 67% 64%

* Participant could not find answer but guessed correctly.

** Participants misunderstood the question and gave the total for State and Local, rather than separate numbers. See Appendix L. Task 2 is not
included in the mean calculations; Task 2A, which is the accuracy for the total for State and Local, is included instead.

*** Participant completed the task, but used the Census search function.

As demonstrated in the raw navigation and eye-tracking data in Appendix L, there was no clear
trend in performance for tasks 1, 2, 6, 7 and 8. This suggests that there is no clear path that
participants followed to get the desired information. Participants clicked back and forth and
searched around the site rather than finding an obvious route to the target information. In fact,
tasks 1, 6 and 8 had the highest amount of back button hits (34, 27, and 34 respectively) across
all users, and task 8 had the highest number of attempts (four participants; 44%) at using Search
or Subject A to Z (which does not exist on the Build-a-Table site; rather, the participants used the
Census functions at the bottom of the screen; See Figure 1). Participants may have thought that
the Census search functions were a part of the Build-a-Table Web site.

For task 7, which had the lowest accuracy rate, the user interface only supported one user in
completing the task successfully. The second user, who successfully completed the task, used
the Census search function.

For task 6, which had the second lowest accuracy rate, the user interface did not support any of
the users in completing the task successfully. Of the four who completed the task, two users
guessed correctly (both users explicitly said that they were guessing), one user used the Census
search function and one user used the Site Map.
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combinad

+ Geography: Detafor 2

+ Government Function: Dataon a 5

(3 Example | Defiritions

Please select which category you would like to base your table en.
You rrust rriake one selection from one of the thres basic categones

 Level of Government  Geography © Government Function

Participants used the Census Search
and Subjects A-Z functions to attempt
some of the tasks.

Figure 1. Main page of the tested Build-a-Table Web site with Census search functions highlighted.

3.2 Participant Efficiency

The average time to complete each task was 3 minutes 22 seconds, which is within the set goal
of 4 minutes or less. However, only 39 responses (56 percent) were correct and included in this
calculation. See Table 4 for detailed times to complete each task and Appendix H for a complete
list of the tasks.

Table 4. Time in Minutes (m) and Seconds (s) to Complete Each Task

Task
Mean time by
Participant 1 2 3 4 5 6 7 8 participant
1 5m22s 8m21s* 10m38s 3m20s 3m24s 10m57s*  16m7s* 4m8s 5m22s
2 5m3s* 4m32s 3m52s 2m20s 3m33s 3m20s 4m18s* 7m4T7s* 3m31s
3 2m43s* 10m38s* 3m44s* 2m2s* 43s 6m58s* 4m39s* 7m9s* 43s
4 4m40s* 5m8s* 6m5s 1m23s 6m37s 3m30s* 1m36s* 3mils 4m19s
5 1m30s* 1mlls* 2m16s 1m31s* 4m9s 9m41s* 1m54s* 1m27s 2m37s
6 1m40s 1m23s 3m3s 1m25s 32s 2mals 4m8s 5m3s 2m29s
7 4m32s 7m16s 1mi12s 1m58s 1m9s 6m49s 4m34s* 3m32s 3m46s
8 (intern) 7m40s 1m42s 3m32s 1m35s 1m38s 3m59s 3m48s* 27s 2m>56s
9 12m22s 1mis 1m32s 8m3s 1m43s 4m59s* 1m52s 7m30s* 4m26s
Mean time by question
(correct responses only) 6m19s 3mlls 4m1ls 2m52s 2m36s ~ 4ml2s 3m 2m58s 3m22s

* Task Failure: time not included in mean calculation.

Table 5 reports the time that elapsed before looking at each AOI. For the ‘Data are for the month
of March’ statement on the main page, six participants looked at the area in the first task, one
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looked at it in the second task, one in the fourth task, and one never looked at it. The average
time elapsed before participants looked at the statement was 3 minutes 20 seconds.

For the link to Example | Definitions on the main page, six participants looked in that area in the
first task, one looked at it in the second task, one in the third task, and one never looked at it.
The average time elapsed before participants looked at this link was 3 minutes 1 second.

For the Currently Selected information on the variables page, no participants looked in that area
in the first task, one looked at it in the second task, one in the fifth task, one in the sixth task, and
one person looked at it in the eight and final task. Five participants never looked at that AOI.
The average time elapsed before participants looked at the Currently Selected information was
21 minutes 5 seconds.

For the link to Census of Government Employment information on the table page, two people

looked at this link in the third task, and seven people never looked at it. The average time that
elapsed before the two participants looked at this link was 9 minutes 24 seconds.

Table 5. Time in Minutes (m) and Seconds (s) Elapsed Before Participants First Looked at AOI

Area of interest

Data are for the
month of March Example | Definitions Currently selected Information link

Participant (on main page) (on main page) (on variables page) (on table page)
1 23s, task #1 21m8s, task #3 35m50s, task #6 0
2 19s, task #1 30s, task #1 0 0
3 21m47s, task #4 0 0 0
4 56s, task #1 1m38s, task #2 27m30s, task #8 0
5 16s, task #1 5s, task #1 0 0
6 13s, task #1 3s, task #1 0 9m45s, task #3
7 18s, task #1 24s, task #1 3mb51s, task #2 9Im3s, task #3
8 (intern) 0 7s, task #1 0 0
9 2m27s, task #2 11s, task #1 17m7s, task #5 0
Mean time to
first look at
AOI 3m20s 3mls 21mb5s 9m24s

It is to be expected that participants looked at the information located on the main page sooner
than they looked at the information on the variables page and table page, as they often looked

around the main page in order to decide how to navigate to the information they were seeking.
However, most participants never saw the information link on the table page, and only four of
nine participants saw the Currently Selected information on the variables page.

3.3 Participant Satisfaction

The average satisfaction score was 6.57 out of 9, and the ratings for individual items ranged from
5.78 to 7.89. Both the average and the individual item scores are above the mid-point, the goal
set for this study. Mean ratings across participants ranged from 4.27 to 9, but only one
participant’s mean rating was below the mid-point of the scale.
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Table 6. User Satisfaction Scores (1 = low, 9 = high)

Arrangement
Use of of Overall Census
Overall terminology Information information Tasks can be Organization of experience Bureau
reaction to Screen throughout displayed on on the performed in a information on Forward Example of finding specific Mean
site: layouts: site: the screens: screens: straight-forward the site: navigation: Page: not information:  terminology:  satisfaction
terrible - confusing -  inconsistent -  inadequate - illogical - manner: never - confusing - impossible - helpful at all difficult - too frequent rating by
Participant wonderful clear consistent adequate logical always clear easy - helpful easy - appropriate participant
1 5 6 7 7 7 7 7 7 7 7 7 6.72
2 7 7 7 7 8 6 7 8 6 5 7 6.82
3 9 9 9 9 9 9 9 9 9 9 9 9.00
4 1 1 9 8 1 7 3 7 3 5 2 4.27
5 5 5 9 3 3 5 3 9 N/A 7 5 5.40
6 6 8 7 8 9 8 7 9 N/A 8 7 7.70
7 8 6 7 8 8 8 8 9 5 8 9 7.64
8 (intern) 7 4 4 7 3 5 4 5 N/A 6 7 5.20
9 7 6 7 6 6 7 6 8 5 6 6 6.36
Mean
satisfaction
rating by
question 6.11 5.78 7.33 7.00 6.00 6.89 6.00 7.89 5.83 6.78 6.56 6.57
Mean
satisfaction
rating by
question
(excludes
participant 3) 5.75 5.38 7.13 6.75 5.63 6.63 5.63 7.75 5.2 6.5 6.25 6.27

Note: N/A = not applicable.



Participant 3 gave all of the questions a satisfaction rating of 9, which indicates lack of thought
given to each individual question. When this participant was excluded from the mean
calculation, the average satisfaction score was 6.27 out of 9, and the ratings for individual items
ranged from 5.2 to 7.75.

Overall, users reported that they were satisfied with the Web site. See Table 6 for detailed user
satisfaction results.

3.4 Eye-Tracking Findings

3.4.1 Gazes

A gaze is the total number of fixations in a given area across all tasks. Table 7 shows the gazes
for each of the four AOIs. Participants looked at the link for Example | Definitions the most,
followed by the *Data are for the month of March’ text, followed by the Currently Selected
information, and then the Census of Government Employment information link. The Example |
Definitions link was viewed 82 total times across all participants across all tasks, with a range of
zero to 28 across participants. The ‘Data are for the month of March’ text was viewed 34 total
times across all participants across all tasks, with a range of zero to 12 across participants. The
Currently Selected information was viewed 12 total times across all participants across all tasks,
with a range of zero to four across participants. The link for Census of Government
Employment information was viewed five total times across all participants across all tasks, with
a range of zero to three across participants. These results demonstrate that participants do not
always look at the important AOIs and often miss the Census of Government Employment
information link altogether. Furthermore, there are inconsistencies across participants
demonstrating that untrained participants have different ways of approaching the Web site.

Table 7. Gazes in AOls

Area of interest

Data are for the month

Participant of March Example | Definitions Currently selected Information link

1 3 2 4 0

2 1 4 0 0

3 2 0 0 0

4 4 4 4 0

5 1 1 0 0

6 9 22 0 2

7 12 28 3 3

8 (intern) 0 2 0 0

9 2 19 1 0
Total gaze
across all

users 34 82 12 5

These data are consistent with the time elapsed to first look at each AOI reported in Section 3.2
of this report. Likewise, it is realistic that participants looked at the information that is located
on the main page more often than they looked at the information on the variables page and table



page, as they often looked around the main page more than the other pages in order to decide
what to do when seeking information. Once again, most participants never looked at the
information link on the table page, and only four of nine participants saw the Currently Selected
information on the variables page.

o~

(c) table page

Figure 2. Heat map for all participants across all tasks: (a) main page, (b) variables page and (c) table page.

21



3.4.2 Hot Spots

The hot-spot data indicate areas where participants spent time looking. Figure 2 shows heat
maps for each page of the Web site for all participants across all tasks. The reds and oranges
indicate longer fixation times, while the greens and yellows indicate shorter fixation times. Red
X’s denote mouse clicks. As shown in Figure 2, no important part of the Web site was
overlooked. However, longer fixations do not necessarily indicate positive results. Based on the
accuracy data, participants likely looked at areas repeatedly or for extended periods due to lack
of clarity in where to find information. This behavior indicates a problem if people are supposed
to use a link to find information, and they actually look at the correct area, but it is not clear what
the link will do. Thus, the issue is not whether the area or link is visible, but rather that its use or
purpose is unclear. Users often wonder where a link will take them and whether they will be
able to get back. This kind of uncertainty may be reflected in the longer fixation times where
there is a relationship between longer times and inaccuracy.

3.5 Positive Findings

e All participants successfully built and downloaded a table (task 5).

e Users commented that once they figured out how to use the Build-a-Table function, they
were pleased with the site and the amount of information that was available to them.
Users said that they liked the colors on the Web site.

Users said that they thought the Main page was well organized.

Performance times were in line with the established efficiency goal.

The average satisfaction score was in line with the established satisfaction goal.

e All individual satisfaction items were in line with the established satisfaction goal.

3.6 Usability Problems

Reasons for the performance deficits are discussed in the list of usability violations that follows.
The usability problems are prioritized from high to low in terms of their effect on participant
performance. The usability issues deal primarily with lack of useful guidance for the user and
difficulty in locating certain pieces of information within the Web site. Fixing the high- and
medium-priority problems as they occur throughout the Web site should result in improvement
in the participants’ performance and satisfaction. Appendix L contains the raw navigation data
collected from the usability study from which we derived the findings and recommendations.

3.6.1 High-Priority Issues

Testing identified four high-priority usability issues, listed below. Recommendations and team
responses follow each finding.

1. Users did not understand that they could only choose one item on the main page. Most
participants, most of the time, tried to select more than one option on the main page. See Figure
3(a). Often, when users clicked on a different category, they did not realize the other category
had been over-ridden. Although most users learned the system over time, one user still did not
realize he could select only one option by the eighth and last task.

One user knew that she could only choose one option, so she went to Main to try a different
route, not realizing that she could select more than one option on the variables page.
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Recommendation: Make the statement “You must make one selection from one of the three
basic categories” more visible. Also, move the items closer together so that when an option is
de-selected, people can see that it has been de-selected.

U.S. Census Bureau AT

Public Employment and Payroll Build-a-Talf (a) tested version

Main Site Map

The U.S. Census Bureau conducts an annual survey of government employment as authorized by Title 13,
United States Code. This survey measures the number of government civilian employees and their gross
payrolls for one month. Data are for the month of March

The Build-a-Table system will allow you to query the Census of Government Employment data from 1997,
2002, and 2007 . All governments across the country were surveyed for the Census years

There are three basic categories of data

+ Level of Government: State government data (all 50 states), local government data (county,
municipality, township, special district, and school district data) or state and local government data
combined

« Geography: Data for a specific state or the District of Columbia

« Government Function: Data on a specific government function, e g., education, health, or highways:

Example | Definitions

Please select which category you would like to base yourtaM
‘You must make one selection from one of the three basic categ

This wording needs
| _— | to be modified.

of Government " Geography ™ Government FURCHon

—

(fold of the page)

[FDF] ur denotes a file in Adobe's Portable Document Format. To view the file, you will need the Adobe® Acrobat® Reader g,
available for free from Adabe.

@ Contact us by email or by phone at (800) 642-4901. For requests from media, contact our Public
Information Office (PIO) at 301-763-3020 or email to pio@census.gov

Sourme: LS. Census Bureau, Goverents Division
Created: August 012008

Census Bureau Links: Home - Search - Sublects A-Z + FAQs - Data Tools - Catalod - Census 2000 - Quality - Privacy Policy » Contact Us
USCENSUSBUREAU
Helping You Make Informed Decisions

Page Last Moiifiec:
Detober 24 2008

\ These options need to be

closer together so that users
can see that an option gets
un-selected when a new
option is selected.

ensus Bureau . oo

(b) revised version

Build-a-Table

Cortzct Us

- Email

- 1 (E00) B42-3901

For e ke imts ane n azmes

Census.gov — Business and Industry — = Build-a-Table

The U.5. Census Bureau conducts an annual suniey of gowermment employment as authorized by Tile 13, United States
Code. This survey measures the number of gowemment ciilian employees and their gross payralls for one month. Data
are for the manth of March

The Build-a-T able system will allow you to query summary data from the Census of Bovernment Employment fiom
1997, 2002 and 2007 for state and local gowemments. All gowemments across the country were surveyed for the Census
years. Please note that individual government data are not available thiough this system

1 NE category that you vwould liketo base your tableon

= =, special districts, schaal districts,
1o%a! govermnment data (county, municipality, township, special district and school district data combined),
sta government data (the 50 states), or state and all local govermment dats combined

[usFota =l
¢ Godkrnment Function: Dataon aspecific gevemmentfunction, e.g, education, health or highnays

[Tffa =l

2 Salect Nefft to sdlect the variables you would like displayed in your table

Next

o TR uEm Bie e, ye 1 milieed e [, FIIGEE oI TN T A

EAU Data Tools |

USCENSUSBUR
Hrlping You Make fafarmed Decimns

|| The instructions have

e W changed, and the items have

| been moved closer together.

Figure 3. Tested version (a) and revised version (b) of the Build-a-Table Web site main page.
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Team Response: Instructions have changed such that “one” is bold and more visible, and the
options have been moved closer together. See Figure 3(b) for a screen shot of the new version of
the Web site.

2. Instructions were not clear, and ‘Next’ was below the fold. Users often did not know what
they were supposed to do to build a table. They were instructed to select which category they
would like to base their table on, but they were not instructed on what to do next. Users often
missed the Next button, altogether. See Figure 3(a).

One user never scrolled below the fold to the Next button, even after being prompted by the test
administrator to look at the entire page to see if there was a way to build a table. This user
always used Main to begin. Another user did not see the Next button until into the fourth task.

Recommendation: Move the Next button above the fold of the page. Add more instructions that
explicitly tell the user to select the Next button. See Figure 4 for an example of how to reword
the instructions.

U.S. Census Bureau -~

Public Employment and Payroll Build-a-Table

Main Site Map Contact Us

The U5, Census Bureau conducts an annual survey of government employment as authorized by Title 13,
United States Code. This survey measures the number of government civilian employees and their gross
payrolls for one month. Data are for the month of March.

The Build-a-Table systerm will allow you to gueny the Census of Government Employment data from 1997,
2002, and 2007 All governments across the country were surveyed for the Census years,

How to Build-a-Table
1. Select ONE category that you would like to base your table on.

There are three basic categories of data:

+ Level of Government: State government data (all 50 states), local government data (county,

municipality, township, special district, and school district data) or state and local government data
combined.

+ Geography: Data for a specific state or the District of Columbia.
+ Government Function: Data on a specific government function, e.g., education, health, or highways.

2. Select Next for your options on the next screen.

 Level of Government  Geography  Government Function

Next

Figure 4. Build-a-Table main page with recommended instructions.
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Team Response: The instructions have been modified. The Next button has been moved above
the fold of the page. A heading, “How to Build a Table” has been added, and the instructions
have been numbered. See Figure 5 for the new version of the instructions.

——
Howto Build-a-Talh A heading has been
Select ONE category that you woul o baze yourw added, and the
’
Lewd of Gowernment: Data for counties, municip aliies, townships, special districts, schoaol districts, all
local gowernment d ata (county, municipality, township, spedal district, and school district data combined), InStrUCtlons have been
state government data (the 80 states), or state and all local government data combined.
numbered. The Next
]Sla'.e and All Local = .
© Geography: Datafora spedific state or the Distriot of Columbia button is no IOnger below
USTal =] the fold of the page.
¢ Gowernment Function: Data on aspecific government function, e.g., education, health or hi

[Tatal
Select Next to select the variabl

Next

ke displayed in your table.

[Puﬂ:ri_'ghlutl A I AdelEs Ecear Sl el Tauem e e,y mi e e s e et e 'EJEIHH!'HHHI“HMIE!.

USCENSUSBUREAU Data Tosls | Cataleg | Census 2000 | Guakity | Privacy Policy | ContsctUs | Home
Helping Yo Make afarmed [ecisnns

Figure 5. Revised instructions on the Build-a-Table Web site main page with changes noted.

3. Users did not understand that they could choose more than one item on the variables
page. See Figure 6. Often, users were able to complete tasks, but only after going back to the
Main page and starting over. As shown in the raw navigation data in Appendix L, participants
used the back button frequently, as well as the Back to Build-a-Table Main and Start Over
buttons.

U.5. Census Bureau P 3 7

Public Employment and Payrell Build-a-Table ThIS Wording needs to be

W Sita Mg o s modified, informing users
BACK to Bulld-a-Table Main Currently Selected 1S Total . that they can Select more
than one choice from each

Year - category.
ErE Add All 5> 42
1997 _ add> |

Please selact the variables you would like the table to display

< Remove
= << Ramave All =l

Variables

Add All > =
Add >

< Remove

<< Remove All =l

Geography

Add All >3
Add >

< Ramave

Delaware =l << Ramove all =

Government Function

ﬂ Add All 3> Educahon Total =]
Add >
< Ramave
<< Remove Al =

Figure 6. Tested version of the Build-a-Table Web site variables page.

25



Recommendation: Revise instructions that explicitly tell participants that they can choose more
than one selection from each category.

Team Response: Instructions on the variables page have changed from “Please select the
variables you would like the table to display” to “Select one or more variables from each
category that you would like the table to display.” See Figure 7 for a screen shot of the variables
page of the site’s new version.

</ U.S. Census Bureau

Build-a-Table
B The instructions have
P Census.goy - Business and Industry = + Buil-a-Table -+ SelectVaiables L Changed to inform users
« Email Select one or morevariables from each category that you would likethe table to display. that they Can Se'ECt more
* 1 (00 8424601 —Tsar than one item from each
T | :
Currertly Selected: Egg; _ Add Ml | Category_
[Seleion from page 1] 1997 Add >
< Remove
=] _<<Remove Al =
—Wariables
FulkTime Employees = Add All 3> -
Full-Time Peny —rTre—
Pan-Time Employees _ hdd> |
Par-Time Pay < Remove
Total Employees e
Total Pay =] ZecRemove Al | =
—Geography
US Total Al Add All >> |
Alabama /]
Alaska Add > |
Avizona
Arkanens < Remove
Celitornie x| EesRemove alll] =

Figure 7. Revised instructions on the Build-a-Table Web site variables page.

4. Users selected Main on the top navigation of the variable page expecting to go to Build-
a-Table Main. People expected to go back to the Build-a-Table main page when they clicked
on Main as this is the way that Web sites usually work. Users rely on norms, as they impart a
sense of familiarity that can be an important part of navigation (Krug, 2006). In this study,
sometimes participants selected Main and then navigated to the Build-a-Table main page from
the Governments main page (which is where Main navigated them to).

Recommendation: Change Main to “Census of Governments Main Page” and add “Build-a-
Table Main” to the top navigation.

Team Response: The overall screen design has changed to the new Census Bureau “look and
feel” that includes a top and left navigation. (Note: This change was recommended in the
October 2008 expert review.) See Figure 8. Now, when users click on Main, they are taken to
the Build-a-Table main page. To go the Census of Governments main page, users must click on
Governments in the breadcrumbs.
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U.S. Census Bureau

Build-a-Table

Cortact Us Census.gov - Business and Industry = Govemments phdea-T ghle —+ Select'Vaiables USGFS mUSt C|ICk on
- Email Select one or rorevariables from each category that vou would likethe table to display. the breadCrumbS tO gO
—

+ 1 (200) 6424601 EsE to the Governments
Currerntly Selected: ggg; - ﬂ ~ maln pa-ge
[Seledtion from page 1] 1997 Add >
< Remove
;l << Remove All d

Figure 8. New Census Bureau “look and feel”” with breadcrumbs supporting navigation to the Census of
Governments main page.

3.6.2 Medium-Priority Usability Issues
Testing identified four medium-priority usability issues, listed below. Recommendations follow.

1. Users had difficulties finding information that was not part of the Build-a-Table function
(e.g., forms). Users were supposed to build a table and then click on the Census of Governments
Employment information link on the table page to access other information, such as forms (task
8), survey mail-out dates (task 6) and response rates (task 7). See Figure 9. However, this
method of retrieving information is not logical and intuitive from the user’s perspective. Users
attempted to access the information from the Main page and usually went off-site (to the Census
of Governments main page) to find the information.

Public Employment and Payroll Build-a-Table

Main Site Map Contact Us

Click your browsers back button to update selection criteria or Start Over
|§| View/Dowvinload as Excel File .USEI’S mUSt C|.ICk on the
View/Download as PDF / information link to access

(POF] or (E] denctes a fle in Adabe’s Portsble Document Fommt, To view the fle, you will need the Adobe® Acrobal® Reader g, important information.

available for free from Adobe.
[Excel] or the letters [xls] indicate a document is in the Microsoft® Excel® Spreadshest Format (KLS). To view the file, you will
need the Microzoft® Excel® Viewer 3, available for free fram Microsofi®,

State and All Local Employment and Payroll Data
By Geography and By Government Function: 2007

Fot information about the data's sampling erroz, nonsampling error, and defintions, select the appgg
Hote: Datais in whole numbers.

2007
Function Full-Time Employees

[ Atabama| Education Totel | 132017

o
Hra': Data is not applicable

Figure 9. Table page with Census of Government Employment link to other information.

For task 6 (In what month was the 1997 Census of Government Employment mailed?), four of
nine (44%) participants successfully found the target information. None of the four participants
used the Census of Government Employment link to access this information. Two of the four
participants who successfully completed the task used the Main link in the top navigation (which
took them to the Census of Governments main page), one used the Site Map link in the top
navigation, and one participant used the Census search function at the bottom of the main page.
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For task 7 (What was the response rate to the Census of Government Employment for county
governments in 20027?), only two of nine (22%) participants successfully found the target
information. One participant (successfully) used the Census of Government Employment link on
the table page, and the other used the Census search function at the bottom of the main page.

For task 8 (Locate a copy of the 2007 Municipalities, Counties, Townships survey, which is also
called the E-4 survey form), six of nine (67%) participants successfully found the target
information. None of the six participants used the Census of Government Employment link to
access this information. Five of the six participants who successfully completed the task used
the Main link in the top navigation (which took them to the Census of Governments main page),
and one participant used the Census search function at the bottom of the main page.

Only two of nine (22%) participants looked at the Census of Government Employment link. See
Section 3.4 of this report for eye-tracking details. For tasks 6, 7, and 8, users needed to access
information via this link. Consistent with the eye-tracking findings, task 7 had the lowest
accuracy score (22% of the participants successfully completed the task), followed by task 6
(44% of the participants successfully completed the task). Task 8 had fair accuracy (67% of the
participants successfully completed the task), but not as low as tasks 6 and 7, since participants
were able to find the information off site on the Census of Governments Web site.

Recommendation: Add separate links for “information” and “forms” to the Main page.

2. Users could not locate the month information [i.e. what month the Census was mailed
(March) and data for the month of March (all reported data)]. Although the statement “Data
are for the month of March” is located on the main page, users seemed merely to skim the
section: six of the nine users had three gazes or fewer for that AOl. When asked about data from
the month of March, users were unable to “find” it (even though it is in the text on the main
page). People typically read only a few words of a page before deciding if it has what they are
looking for (Redish, 2007, p.102), and since users would likely not consider the month of
mailing as an important piece of information, it is predictable that they did not see the
information, if they read it at all. If they “saw” it, they are likely not to have processed it
sufficiently to remember it later. At the point where they might have seen the date, it was just a
random piece of information. The date was not highlighted or otherwise emphasized to indicate
that it was of any special importance.

One participant looked for month data on the Excel sheet. Another participant specifically
looked for dates.

Tasks 1 and 2 specifically asked about data for March. These two tasks had the third and fourth
lowest accuracy rates of the eight tasks.

Recommendation: Make it clear that the data are reported in the month of March. Include the
text “Data for March” on the variables page and the table page. ‘The month of” should be
eliminated as people know that March is a month, and wording on Web sites should be minimal.
Consider including the year in the text, as this is also important information.

28



3. Users were confused by Census terminology and jargon. Normally, this is a recurring,
high-priority issue in SRD’s evaluations of the Census Bureau’s public Web sites. However, in
this usability study, few users commented on Census jargon. Some users commented that they
did not know what some words meant. Confusing terminology included “radio button” and
“variables.”

Recommendation: Eliminate technical jargon and use words that are typical for novice users. At
the very least, define acronyms and unfamiliar terminology.

4. There was not a site-specific search function. Although a Web site without a search
function is often considered unusable (Krug, 2006), in this study the lack of a site-specific search
function did not cause major issues. However, jumping around the Web site was frustrating for
many participants, as users generally want to get information in the fewest possible steps (Lynch
& Horton, 2001). In this study, three of nine (33%) participants used the Search and Subjects A
to Z functions located on the bottom of the screen, below the fold of the page, which are not a
part of the Build-a-Table site, but rather are for the entire Census Bureau. See Figure 10.
General users are not likely to distinguish the Census Bureau’s site from the Build-a-Table sub-
site. If they see “search’ on the page, they will assume that it will be helpful.

Next

[PDF] or L) denates a file in Adobe's Portable Document Farmat. Ta view the file, you will need the Adobe® Acrabat® Reader g, Thl’ee
awailable for free from Adobe. part|C|pantS
Contact Infarmation used the Census

@ Contact us by email or by phone at (500} 642-4901. For requests from media, contact our Public Bureau search
Information Office (PIO) at 301-763-3030 or email to plo@eensus gov fUﬂCtiOﬂS

Soarme: U5, Camsus Bumay, Govemments Division
Created: August01 2008

e —

Census Bureau Links: 15 - Search - Subjscts &7 - FAQs - DatNDols - Catalog - Census 2000 - Qualty - Privacy Policy - Cortact Us
USCENSUASBUREAU
lake informed Decisions

Page Last Modifie
October 24 2008

Figure 10. Tested version of the Build-a-Table main page with Census Bureau search functions.

Recommendation: Offer users a site-specific search function with a search box at or near the top
of the Build-a-Table page. See Figure 11 for an example.

U.S.'-'(.Iensﬁs Bureau

The 2008 Statistical Abstract

The National Data Book

| Main | Overview | PDF Version | Earlier Editions | Order |

IROWSE SECTIONS: Search the Abstract

s commodation. Food, & Other What is the Statistical Abstract? - '
Benices I |

. The Statistical Abstract of the United States, published since 1873, is the Popular Sections
prariculture authoritative and comprehensive surmmary of statistics on the social, poliical

Figure 11. Example of a site-specific search function.
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3.6.3 Low-Priority Usability Issue
Testing identified one low-priority usability issue, listed below. A recommendation follows.

Government functions listed on the main page were not alphabetized. Presently, the list of

Government functions does not seem organized in a systematic way. See Figure 12. Users tend
to use previous knowledge to make inferences and expectations about the physical world and so
would expect this list to be in alphabetical order (Forsythe, Grose & Ratner, 1998).

—

Users expect these
items to be in
alphabetical order.

@ Conlact s by email or by phone at {800 842420\ Far r
Infarmatian Cifica (FIO) at 201.763-3030 or amiail i ik

Figure 12. List of government functions on the Build-a-Table main page.

Recommendation: Present all lists in alphabetical order, unless a business case can be made for
grouping the items in some other way.

4.0 Conclusion

Although accuracy in this usability study was moderately high (64%), it did not reach the
established goal of 75 percent. Analysis of testing data identified key issues that led to many
task failures, as well as user frustrations. The Public Employment and Payroll Build-a-Table
team has implemented many recommendations that were provided in the Quick Report, along
with several other major changes to the Web site. Further improvements to the site can certainly
improve the user’s success.

Participants in this usability study were diverse in age, education and comfort with Web sites and
the Internet. Individuals who were more comfortable with the Internet and with higher education
were likely to understand the site better than those who were at a more novice level. Future
usability testing on the site should aim to include a diverse sample of both novices and experts.
Testing with users who have disabilities is also recommended to determine whether the site
works for special-needs users. Technical compliance with federal regulations on accessibility
does not guarantee usability for everyone (Theofanos & Redish, 2003, 2005).

Once the development team has completed all changes, we recommend conducting further

usability testing to evaluate whether the changes to the user interface support users in achieving
their goals on the Build-a-Table Web site.
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Appendix A. Build-a-Table Web Site Main Page Prior to 2008 Expert Review

W\

Public Employment and Payroll Build-a-Table

U.S. Census Bureau

Main Site Map Contact Us

The U5 Census Bureau conducts an annual survey of government employment as authorized by Title
13, United States Code. This survey measures the number of government civilian employees and their
gross payrolls for one month. Data are for the month of March.

The Build-a-Table system will allaw you to guery the Census of Government Employment data from 1997,
2002, and 2007. All governments across the country were surveyed forthe Census years.

There are three basic categories of data:

& Level of Government: State government data (all 50 states), local government data (county,
municipality, township, special district, and school district data) or state and local government data
combined.

& State: Data for a specific state or DC.

& Government Function: Data on a specific government function e.g., education, health, or
highways.

Example | Definitions

Please select which category you would like to base your table on.
You must make one selection from one of the three basic categories.

 Level of Government  State  Government F

_New_|

Contact Information

@ Contact us by small or by phone at (800) 642-4901.

Souwrce: LS Census Bureay Governments Diviaion
Created: August 01 2008
Last revised: August 01 2008

Census Bureau Links: Home - Search - Subleds A2 -FAQ- Data Tools - Catalog - Consus 2000 - Quality - Privacy P olicy - Contact LIS
USCENSUSBUREAU
Helping You Make Informed Decisions
Page Last Modified:

Figure Al. Build-a-Table main page prior to 2008 expert review.
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Appendix B. Recommendations from the Expert Review (Ashenfelter, Romano & Murphy,
2008)

Note: Items that were changed are marked with an asterisk (*).
High-Priority Issues

*1. Potentially Confusing Category labels

In the descriptions of the categories below, it is difficult to tell the difference between the first “Level of
Government” and second “State” categories because the description of “Level of Government” begins
with “state government data”. It appears that these categories offer the same information.

e Level of Government: State government data (all 50 states), local government data (county,
municipality, township, special district, and school district data) or state and local government
data combined.

e State: Data for a specific state or DC.

e Government Function: Data on a specific government function e.g., education, health, or
highways.

Recommendation: In the explanatory text, explain the differences between these categories without using
the other category names (e.g., do not begin the level of government description with “state government
data” when the very next category beneath “Level of Government” is “State.”

2. “State” vs. “State and all Local”

The first sample task, “How many full-time police officers were employed by the District of Columbia in
March 2002? What was the corresponding gross payroll?

Answer: 3,560; $18,386,338 requires selecting “State and all Local” for “Level of Government” on the
selection screen (Figure 1). If only “state” is chosen, the result is an NA in the data table (Figure 2). Since
the question refers specifically to DC, a user might expect that the “state” selection be the correct one.

Public Employment and Payroll Build-a-Table

Main Site Map Contact Us

Click your browisers back button to update selection criteria or Start Over

[ viewDownload as Excel File
T viewDownload as PDF

[PDF] or T denotes a fils in Adobe's Porlable Documment Format, To view the file, you will need the Adobe® Acrobat® Reader o,
available for free from Adobe

[Excel] or the letters [xls] indicate a document is in the Microsoft® Excel® Spreadsheet Format ($LS). To wiew the file, you will
need the Microsoft® Excel® Views: @, available for free from Microsofti®

Police Officers Only Government Employment and Payroll Data

By State and By Level of Government: 2002

SBOURCE: This table was user generated from the Census Bureau's Build-a-Table tool with data from the Census of Government Employment
For information about the date's sampling error, nonsampling error, and definitions, select the appropriate fink

Hote: Data is in whole mimbers

2002

Level of Government | Full-Time Employees

‘ De Md All Local 3560

‘Nes. Dataiznat

Figure 1: State and All Local condition for correct answer in task #1.
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Fublic Employment and Payroll Euild-a-Table

Main Site Map Contact Us

Click your browsers back button to update selsction criteria or Start Over

B viewDownload as Excel File
T viewDownload as PDF

[PDF] or T denates a file in Adobe's Portable Document Format. To view the file, you will need the Adobe® Acrobat® Reader 3,
available for free from Adobe

[Excel] or the letters [xls] indicate a document is in the Microsoft® Excel® Spreadsheet Format (LS). To view the file, you will
need the Microsoft® Excel® Yiewsr 0, available for free from Microsofi®.

Police Officers Only Govermment Employment and Payroll Data

By State and By Level of Government: 2002

BOURCE: This table was user generated from the Census Bureaw's Build-a-Table tool with data from the Census of Government Employment.
For information abowt the data's sampling error, nonsampling error, and definitions, select the appropriate link.

Mote: Data is §

Level of Government | Full-Time Employees
R WA

Figure 2: Results of query if only “State” is selected.

Recommendation: Clarify the difference between “State” and “State and all Local” somewhere on the
page so that users with this type of question will select the correct option. Perhaps this clarification could
be added to the content of the “Definitions” link at the bottom of the page (see the figure in Appendix A
for a screen shot of this entire current page, including the “Definitions” link).

3. Accessibility Issue: Image as Bullet

Since this screen must be accessible to screen-reader users, the image and bullet tags and alt text should
be written in XHTML and be meaningful as read by screen-readers. The blue ball used as a bullet is
tagged with “*”. The screen-reader user will hear “asterisk”. Figure 3 shows this bullet and the XHTML
code below shows the image file and the uninformative ALT text.

<img src="Images/bluebuli.gif" ALT="*" width="10"
height="10" style="margin-left:lem;" />

Recommendation: Replace the image bullet with a plain black text bullet.

« Level of Government: State government data (all 50 states), local government data {county,
municipality, township, special district, and school district data) or state and local government data
combined

« State: Data for a specific state or DC

+ Government Function: Data on a specific government function e g., education, health, or highways

Example | Definitions

Please select which category you would like to base your table on.
You must make one selection from one of the three basic categories

@ Level of Government  State © Government Function

State and All Lacal =

Next

tact Information

@mlacl us by email or by phone at (800} 642-4901

Figure 3: Blue image bullet.
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Medium-Priority Issues

1. Overall “Look and Feel”

The Web site does not reflect the new Bureau “Look and Feel”.

Recommendation: This page should adopt the new Census Bureau “look and feel” that includes a top and
left-pane navigation. The links that are included on the page could be included in these navigation bars to
organize the information. Figure 4 shows a screen capture of the Monthly and Annual Wholesale Trade
page, which has incorporated this new design.

</ 1.8, Census Bureau

Release Schedule  Monthly & Annual Wholesale Trade Announcements

The Upsoming Aeleaca DStes 1,
ar below:

5 Ihres inlegrated programs 1o produce measures of econcimic actiy Hoti
Wi

o MATS iAo ZFE%:B onthly Wholesale Traus Surdey (MWTS)
jﬁgﬁ_j: :‘f:J + Aunual Whalssala Trade St urvey (AWTS)
e o » Economic Census of Wholesale Trade
Tt quarter 2000 — Latest Manthly Wi

Click hera 1o access the 2008
WS Reizass Schedule POF
78 40| « Lotest oty

Related Sites

wlesale Trade Rep et ————————————
Tho Mlan ch 2008 regort d on Wy 3, 2005 o 1000 am

= Track fieport Excel [13040]  FOF [+1550]

Sares Tabies through March 2005

= danusry 1582 - present (Adusted) Sl 1954
= damuary 1362 - present 0 Ackusted)  Secel (305

Contact Us
Cortact the Manthly and

—1 atae = Trads Ba

Flgure 4: Web site mcorporatlng new Census “look and feel.”

*2. The email link does not always go directly to users’ email boxes. This may lead to frustration as
people are trying to find the email address and cannot directly link to it. Include the actual email address
in contact information at the bottom of the page.

*3. The text is the example is dense and people are likely to be frustrated. Most users skim for key
words and relevant information, and then quickly move on (Redish, 2007). Users read about 20% of the
content on the page (Weinreich, Obendorf, Herder, & Mayer, 2008, as cited in Nielsen, 2008). Have the
example be a PDF document that people can print and follow along with. On the pdf document, instead
of saying “select the radio button next to “State”, show a graphic of what they would actually see on the
page and “show” the user what they have to do. Rewrite the text in a way that is more appropriate for the
Web. This includes short bulleted sentences (Redish, 2007).

4. Example and Definitions are currently in the middle of the page and are of main focus. Move
Definitions to the top navigation bar. Move Example below the Next button. See Figure 5 for an
example.
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U.S. Census Bureau )\ ¥ =

Public Employment and Payroll Build-a-Table

 a———
Main Site Map | Definitions | Contact Us

The U.S. Census Bureau conducts an annual survey of government employment as authorized by Title 13,
United States Code. This survey measures the number of government civilian employees and their gross
payrolls for ane month. Data are for the month of March

The Build-a-Table system will allow you to query the Census of Government Employment data from 1997,
2002, and 2007 All governments across the country wers surveyed for the Census years

There are three basic categories of data:

+ Level of Government: State government data {all 50 states), local government data (county,
municipality, township, special district, and school district data) or state and local government data
combined.

+ State: Data for a specific state or DC

+ Government Function: Data on a specific government function e.g., education, health, or highways

Please select which category you would like to base your table on.
You must make ane selection from one of the three basic categories

 Level of Government  State " Government Function

Next

See an Example of how to make a table.

& Coantact ns hw amail ar bv nhona at (80N K42 4901 LI

Figure 5: Example of moving Definitions to the top navigation bar. Move Example below the Next button.




Appendix C. Tested Version of the Build-A-Table Web Site with AOIs defined

Public Employment and Payroll Build-a-Table

Wain Site Map. Contact U

The LS. Census Bureau conducts en annual survey of govemment employment as authonized by Tile 13,
United Stetes Code [wummem civilian employees and their gross

panyredls for one monthy Data are for the month of March

The: Build-a-Tabhe sys of Govermment Employrnent data from 1997,
2002, and 2007 All pavammants acrass the country wians suneyid for the Cansus years

There ane three basic cateqores of data.

+ Laval of Govarnmant: State govemment data (all S0 states). local govemment data {county,
municipaity, township, special district, and school distict data) or state and lacal govemment data
combined

« Geography: Data for a specific state or the District of Columbia

= Government Function: Diata on a specific govemnment function, & 9., education, heakh, or highways

Example | Definitions

Please select which % base your table on.
iou st make one sekac non Imrl ong of the three basic categorias

© Level of Government © Geography  Government Function

Mot |

1POF) o L] danctus & s in Adoba's Bartabia Dincumant Farmst To view the i, you will nasd the Adohef Acrohat® Reade: (3,
wailable toe fram fram Adobs

@ Conactusty | ar by phane at (800) 642.4901_ For requasts rfom M, contact our Pubiic
Information Office (PI0) at 301-T62-3030 or amail to pio@es

Sower, (15, Corin Bumra, Guvermwenls Division
ot Ayt 01 2008

Cetvinin Buresu Linke: 1t « asrch s Suteecs

2.4 +EAQS +Qaln Toy + Catakog - Cetann JU00
USCENSUSBUREAU
Helping Yous Make dnformed Dections
Poge Lt Modites
Catobar 24 7008

Figure C1. Tested version of Build-a-Table main page.




Public Employment and Payroll Build-a-Table

Maln Site Map
BACHK to Build-a.Table Main Currently Selected LIS Total I

Please selectthe variables you would like the table to display

Year
2007 E] Add A 2> E]
00 ——
157 L Lo |
< Remove
= << Romove All =
Varlables
FulFTime Emgloyeas =] Add Al 35 =]
Full Time Pay 1
ParT Acd
P Tima Fay
Tatel Empleyees p e
Tatel Pary 2| _<< Romove Al =l
Geography
S Tow ‘l Add Al 52 Alabams =]
Alnska ——— 1 |caleda
Aditans Add > Connecticu
Acknnins o
Calitrea T
Dialawans =l << Remove Al k- |
Government Function
Toral fl Add Al 52 Education Tetsl o |
Migher Educaton Instuctional Empioyees —
1 Cither Hegher Educaton Ade >
Elemertany and Secondary Instucional Employeas
Al Cithes Elemuriany and Swcondary Educatan il
Cehar Education = =< Remove All =

Figure C2. Tested version of Build-a-Table variables page.

Public Employment and Payroll Build-a-Table

Main Site Map Contact Us
Click your browsers back button to update selection critena or Start Over

B viewDownloa
i

d as Excel Fil
da

(POF) or (=] denates a file in Adsbe's Portable Documers Fomiat. To view the fle, you wil need the Adobe® Acrobat® Readsr o
avalable for liee b,
[Encel] o the letters [xls] mdate & document is in the Micosof® Excel® Sproadshust Fomat (-LS). To view the fle, you wil
mepd the Microsof® B ocel® Viewsr B availabde for frae from Mcrosofii

State and All Local Employiment amd Fayroll Data

SOURCE Thos tbde was user gesseraled from tie Cenaus Burends Balda.T, daka Frem e Cezua 5 1 Emmplerymesi I
thet dabe's sampling o, . and defintions, selact the -
Biote: Data i3 im wiele smbess

2007 1002 1997
Fun Full-Time Employess | Full-Time Emplayees | Full Time Empleyees
Alabama | Education Totsl 1257 120 468 1725

H/A" Deta is not applicable

Diafinitions

By Geagraphy and By Government Function: 1997, 2002, and 2007 I

Figure C3. Tested version of Build-a-Table table page.
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Appendix D. Revised Version of the Build-a-Table Web Site

U.S. Census Bureau

Build-a-Table
S Census.gov - Business and Industry % - Build-a-Table
- Email The U.S. Census Bureau conducts an annual survey of t | t as authorized by Title 13, United States
« 1 (E00 8424001 Code. This survey measures the number of gowernment civilian employees and their gross payrolls for ene month. Data

are for the month of March
The Build- a-T able system will allow youto quens summany data fram the Cersus of Government Employmert from
1997, 2002 and 2007 for state and local governments. All gowemments across the country were surveyed for the Census
years. Please note thatindiidual government data are not awailable hiough this system.

How to Build-a-Table
1 Select BHE categorythat you would like to base your table on

' Levd of Government: Data for sounties, municip alities, tovnships, special distrists, sehoal districts, all
lacal government data (oo unty, municipality, tovnship, special distriet, and sehosl district data combined),
state government data (the 50 states), or state and all local gowemment dats combin ed.

T Geography: Datafora spedfc state orthe District of Columbia
[usTe =]
~ Government Function: Data on aspeeific governmentfunction, 2.g., education, health of highways
[Tl
2 Select Nexd to select the warisbles you would like displayed in your table

_toxt_|

Cortact Us Cenzuz.goy - Buzsiness and Industry - = Build-a-Table - Select\anables
« Email Select one or morevariables from each category that you would likethe table to display.
- 1 (200) 6924001 iy
Currerdly Selected: gg g; = ERCI H
[Seledtion from page 1] 1997 Add >
< Remove
=] _=<Remove All =
—Wariables
Full-Time Employees = Add All 3>
Full-Time Pay — v —1
PartTime Employees Add >
Part-Time Pay < Remaove
Total Employees ———————
Total Pay =] _<<Remove All | =
—Geography
US Tatal & Add All >3 =
Alabarna ————
Alaska TR
Arizona
< Remove
Arkansas
Califomnia x| _<<Remove All | =

Figure D2. Revised version of Build-a-Table variables page.



U.S. Census Bureau

Build-a-Table

% Build-3-Tahle % Selectansbles - Output Table

Cortact Us Census gov = Business and Industry -
« Email L
asE File

ey sazent ® ViewiDownioad as PDF

Total Govenunent Employment and Payroll Data

By Geography and By Level of Government 1297 and 2002
RCE: This table was user goneraled from the Census Busea's Buld. o Tahle tool with dats from the Consue

U
For mformstion about the data's samping emor, nonsampling exror, and dsfinitions, select the sppropriste knk

Note: Data is i whole numbers.
2002 1997
Levelof | coyyimg pay "",‘,‘3""‘ Total Pay | Full:Time Pay P";‘;"“ Total Pay
Aaska | Sute 91197719  $5001645| $96.%964|  SBATB0I6| 84216078 90796004
All Local 389147 112 §7 509 321 $96,756 433 $781TIB5E 5014 472 $83,188 328
Arizona State $185742 329 $20810774 $206 553,103 $13B719.423 $15514 037 §154 233 456
SHA02E| S pm T

$561577.317 | $45229041 $E07 207 258 $3WA9535
$1.099.991 579 $133005394 | $1232.996 373

$3657 BO3ETE | $373082.451 | $4030 596337

Al Local
California | - State $1522903063 | $199350.900 | §1.721.462963
Al Local $523BB72.174 | $5ESE20.146 | §5804 432 320

/A" Datais not apphcsble

=l izsl Tawem e e, yan milieed e & sl for Tu s fom Acote

POF of] e raies 2t 1 Adoe's
[Ex2 | artie (et 0] nEeste @ semime 1te
M .

Figure D3. Revised version of Build-a-Table table page.



Appendix E. General Introduction

Thank you for your time today. My name is (Test Administrator). | work here in the U.S.
Census Bureau Usability Lab, and | will be working with you today. In this lab, we evaluate
how easy or difficult Census products are to use. We bring in people like you who are potential
users of our products to try them out while there is still time to make changes to them. What
works well, we keep. When potential users such as you have difficulty with something, we have
an opportunity to fix it.

Today, we will be evaluating the Build-A-Table Web site by having you work on several tasks.
There are two parts to our session. First, you will complete 8 tasks using the Build-A-Table Web
site. Then, at the end of the session, you will fill out a questionnaire about your experience
during the session. The entire session should last about an hour.

Before we start, there is a form | would like you to read and sign. It explains the purpose of
today’s session and your rights as a participant. It also informs you that we would like to
videotape the session to get an accurate record of your feedback. Only those of us connected
with the project will review the tape and it will be used solely for research purposes. Your name
will not be associated with the tape or any of the other data collected during the session.

[Hand consent form; give time to read and sign; sign own name and date.]
Thank you.

Before we start, | want to tell you that you can’t make a mistake or do anything wrong here.
Difficulties you may run into reflect the design of the Web site, not your skills or abilities. This
product is intended for people like you. Where it works well, that’s great. If you have a problem
using parts of it, that is also great, because you will help us to identify these places. We are
going to use your comments and data as well as comments and data from the other participants to
give feedback to the developers of the site. Your comments and thoughts will help the
developers make changes to improve the site. | did not create the site, so please do not feel like
you have to hold back on your thoughts to be polite. We are not evaluating you or your skills,
but rather you are helping us see how well the site works. Please share both your positive and
negative reactions to the site. And remember, there are no right or wrong answers.

In addition to the tasks | am about to give you, we are also going to do some eye tracking to
record where you are looking on the screen. It will be very simple. In a moment, we will do a
very short simple task that will allow the computer to find your eyes.

I am going to give you 8 tasks to work on. Your comments are very important to us. 1’d like
you to tell me your impressions and thoughts as you work through the tasks. So give me your
open impressions, both good and bad of what you see and what you experience on the site.

While you are working, 1 would like you to think aloud. In other words, 1’d like you to tell me
what you are thinking, describe the steps you are taking, what you are expecting to see, why you
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are doing what you are doing, what you are going to do, and why. Tell me why you clicked on a
link or where you expect the link to take you. Tell me if you are looking for something and what
it is and whether you can find it or not.

Ok, now we will practice thinking aloud. [open www.craigslist.com and do practice question.]

Ok, that was fine. Do you have any questions about the “think-aloud” process we’ve just
practiced and that | have asked you to use?

[Calibrate eyes] Now | am going to calibrate your eyes for the eye tracking. Please position
yourself in front of the screen and sit the same way you will sit while working on the tasks. You
will want to see your nose in the reflection at the bottom of the monitor. To calibrate your eyes,
please follow the blue dot across the screen with your eyes. [Do Calibration]

Ok, now we are ready to begin. | am going to go around to the other room and do a sound check.
While I am doing that, please take a moment to complete this computer usage and internet
experience questionnaire. Here are your task questions. When we are ready to begin, you will
be working with them. Also, here is the questionnaire you will complete at the very end. | will
tell you when to complete this.

[Hand computer experience form. Set the task questions and questionnaire by participant.]

I am going to leave, but we will still be able to communicate through a series of microphones
and speakers. Do you have any questions?

[Go to control room. Do sound check. Start video recording.]

Now we are ready to begin. For the next 60 minutes, | will ask you to work on the 8 tasks. We
will begin each task by having you read the task question out load. As you work, remember to
talk to me about what you are thinking and feeling. Once you have found the information you
are looking for please state your answer aloud. For example, say, “My answer is ---" or “This is
my final answer”. After each task, | will return you to the page where you can begin the next
task.
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Appendix F. Consent Form

Consent Form
Usability Testing of the Build-a-Table Web Site

Each year the Census Bureau conducts many different usability evaluations. For example, the
Census Bureau routinely tests the wording, layout and behavior of products, such as Web sites
and online surveys and questionnaires in order to obtain the best information possible.

You have volunteered to take part in a study to improve the usability of the Build-a-Table Web
site. In order to have a complete record of your comments, your usability session will be
videotaped. We plan to use the tapes to improve the design of the product. Only staff directly
involved in the research project will have access to the tapes. Your participation is voluntary and
your answers will remain strictly confidential.

This usability study is being conducted under the authority of Title 13 USC. The OMB control

number for this study is 0607-0725. This valid approval number legally certifies this
information collection.

I have volunteered to participate in this Census Bureau usability study, and | give
permission for my tapes to be used for the purposes stated above.

Participant’s Name:

Participant's Signature: Date:

Researcher’s Name:

Researcher's Signature: Date:
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Appendix G. Questionnaire on Computer Use and Internet Experience

1. Do you use a computer at home or at work or both?
(Check all that apply.)
___Home
__Work

2. If you have a computer at home,
a. What kind of modem do you use at home?
___Dialup
___Cable
___ Other
__Don’t know

b. Which browser do you typically use at home? Please indicate the version if you can recall it.

__Firefox
___Internet Explorer
___Netscape

___ Other

___Don’t know

c. What operating system does your home computer run in?
__MACOS
__Windows 95
___Windows 2000
__ Windows XP
____Windows Vista
___ Other
___Don’t know

3. On average, about how many hours do you spend on the Internet per day?
___Ohours
___1-3hours
___4-6 hours
___7or more hours

4. Please rate your overall experience with the following:
Circle one number.

No experience Very experienced
Computers 1 2 3 4 5 6 7 8 9
Internet 1 2 4 5 5 6 7 8 9

5. What computer applications do you use?
Mark (X) for all that apply
_ E-mail
____Internet
____Word processing (MS-Word, WordPerfect, etc.)
___ Spreadsheets (Excel, Lotus, Quattro, etc.)
___Accounting or tax software
____Engineering, scientific, or statistical software
____Other applications, please specify
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For the following questions, please circle one
number.

6. How comfortable are you in learning to
navigate new Web sites?

7. Computer windows can minimize,
resize, and scroll through. How
comfortable are you in manipulating a
window?

8. How comfortable are you using and
navigating through the Internet?

9. How often do you work with any type of
data through a computer?

10. How often do you perform complex
analyses of data through a computer?

11. How often do you use the Internet or
Web sites to find information? (e.g., printed
reports, news articles, data tables, blogs,
etc.)

12. How familiar are you with the Census
(terms, data, etc)?

13. How familiar are you with the current
Build-A-Table Web site (terms, data, etc.)?

Not Comfortable

1 2 3
1 2 3
1 2 3
Never
1 2 3
1 2 3
1 2 3
Not familiar
1 2 3
1 2 3

Comfortable

Very Often

Very familiar
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Appendix H. Task List

1. How many full-time police officers were employed by the District of Columbia in March
2002? What was the corresponding gross payroll?

2. What was the total full-time equivalent employment for state government and local
government in Maryland for March 2002?

3. Among California, New York or Texas, which state had the most state public welfare full-time
employees in 19977

4. Did Oregon have more hospital employees in 1997 or 2002?
5. Create any table and download it to an excel file.
6. In what month was the 1997 Census of Government Employment mailed?

7. What was the response rate to the Census of Government Employment for county
governments in 2002?

8. Locate a copy of the 2007 Municipalities, Counties, Townships survey, which is also called
the E-4 survey form.
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Appendix I. Satisfaction Questionnaire

Please circle the numbers that most appropriately reflect your impressions about using this Web -

based instrument.

1. Overall reaction to the Web site:

2. Screen layouts:

3. Use of terminology throughout the Web
site:

4. Information displayed on the screens:

5. Arrangement of information on the screen:

6. Tasks can be performed in a straight-
forward manner:

7. Organization of information on the site:

8. Forward navigation:

9. Example Page:

10. Overall experience of finding
information:

11. Census Bureau-specific terminology:

Additional Comments:

terrible
1 2 3 4 5

confusing
1 2 345

inconsistent
1 2 34 5

inadequate
1 2 345

illogical
1 2 345

never
1 2 345

confusing
1 2 345

impossible
1 2 345

not helpful at all
1 2 345

difficult
1 2 345

too frequent
1 2 345

6

6

6

6

wonderful
7 8 9 notapplicable

clear
7 8 9 notapplicable

consistent
7 8 9 notapplicable

adequate
7 8 9 notapplicable

logical
7 8 9 notapplicable

always
7 8 9 notapplicable

clear
7 8 9 notapplicable

easy
7 8 9 notapplicable

very helpful
7 8 9 notapplicable

easy
7 8 9 notapplicable

appropriate
7 8 9
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Appendix J. Debriefing Questions

1. Can you walk me through your thinking on why you marked (a particular QUIS item)
especially low/high? (Do this for several low/high QUIS ratings).

2. What do you think of the basic screen layout?
a. Overall?
b. Colors?
c. Links and information around the center pane?
d. Context of the information on the homepage?
e. Other?
3. What do you think of the navigational methods?
a. Previous and Next buttons?
b. Center navigation?
d. Other?
4. What do you think about the instructions on the first page of the Web site?
5. What did you like best about the Web site?
6. What did you like least about the Web site?
7. Is there anything that you feel should be changed?
8. Is there anything that you feel should stay the same?

9. How easy or difficult do you feel it was to complete the tasks? What made a task easy or
difficult?

10. Is there anything you would like to mention that we haven’t talked about?

11. Additional Comments:
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Appendix K.

Participant 1:
Participant 2:
Participant 3:
Participant 4:
Participant 5:
Participant 6:
Participant 7:
Participant 8:
Participant 9:

Participant Orders

Task1>22>32>4->52>26>7->8
Task5>7>324>2>82>6~>1
Task2 >72>6>3>1>8->5->4
Task72>22>1>52>6>4->8->3
Task6 >32>52>2>8->1>7>4
Task4 >8>3>72>2>26>1->5
Task4 >82>32>72>22>26>1->5
Task12>26>32>4>52>2->7->8
Task52>62>324>8>21>2>7
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Appendix L. Eye-tracking Data, Raw Navigation Data and Participant Comments

Note: “P” refers to Participant. “TA” refers to Test Administrator.

Eye-tracking heat map key: red = more/longer fixations, green = less/shorter fixations. Heat
maps for each task are the composite of all participants.

Task 1: How many full-time police officers were employed by the District of Columbia in
March 20027 What was the corresponding gross payroll?
Eye-tracking Data

.....

e i iy P

Raw Navigation Data
Participant 1
1. Success
2. Level of Government-All Local - Government Function-Police Officers Only -
Next = 2002 - Add - Full Time Employees = Add All - Part Time Employees
- Remove - Part Time Pay - Remove - All Local > Add - DC - Add »>
Submit

Participant 2

1. Failure

2. Geography-DC - Next - 2002 - Add - Full Time Employees - Add - Police
Officers only - Add - Submit - P opened in excel - P said, “I am thinking about
where to go for the corresponding payroll.” - Start over > Site Map = Public
Employment & Payroll State and Local Government 2002 link - Viewable Data >
P scrolled through State Summary Table looking for DC, but it was not there - State
and Local Government Employment and Payroll - March 2002 related Information -
US Summary Table = back = P chose District of Columbia from the Summary
Table scroll menu - P answered 18,388,707
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Participant 3
1. Failure
2. Subjects Ato Z > E - P looked for employees - Employment: Public Employment

and Payroll - back - forward - P said, “I’m not sure if police are state or federal.”
- Federal Government Data - 2002 - Federal Government data by government
function - P gave answer for total: 109,278 - back - forward -> P gave answer for
payroll: 627,716,786

Participant 4
1. Failure
2. Site Map - 2002 - Census 2002 Brochure = X to close = 2002 Governments

3.

Integrated Directory - P said, “Now | can’t find it in front of me so | am going to
click all over the place.” - back - 2002 Local and Government Directory Survey
Forms - back - P said, “If there was something that said ‘search for’ then I could
put in ‘police officers March 2002 DC’” - 2002 Census Brochure - P typed “Police
Officers” in Find function at top of PDF - P said, “I’m frustrated. Is there
something on here that is actually straight-forward?” - X to close - back - 2002
- back = 2002 edition - P said, “I’m not liking this site. | want to move on to the
next questions. 1’m already frustrated.”

P ended task.

Participant 5

1.
2.

Failure

Main - Local Government only - 2002 - District of Columbia - P said, “I am
confused because there are two different police.” - P added totals of both for
answer.

Participant 6

1.
2.

Success

Geography-DC - Next - 2002 - Add - Full Time Employees, Full Time Pay >
Add - State and All Local, State, All Local > Add - Police Officers Only - Add
-> Submit

Participant 7

1.
2.

Failure

Geography-DC - Next = 2002 - Add - Full Time Employees, Total Pay - Add
- P said, “Again, it doesn’t say March so | hope it is March.” - State > Add »>
Police Officers only - P said, “It would be nice if there were in alphabetical
order...not certain why they are in this type of order.” - Add - Submit - back >
State - Remove - All Local > Add - Submit = P answered 18,388,707

Participant 8

1.
2.

Success

Main - P said, “I’m looking for something that says ‘employment’.” > General
Information- Public Employment and Payroll > Federal Government Data - 2002
—-> Federal Government data by State - back - Main - Criminal Justice Stats-
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Special Topics = Criminal Justice Expenditure and Employment Extracts - back -
back = back - back - back - back = P said, “Maybe there is something here.” >
P read page. = Geography-DC - Next - 2002 - Add - Full Time Employees -
Add -> State and All Local - Add - Police Officers Only - Add - Submit > P
gave answer for number of Police Officers. = P said, “Now | am looking for payroll
data. Maybe if I look at it as a PDF, it will give more info.” - PDF - P said, “It
says DC Government Employment and Payroll Data, so | am confused.” - back > P
added Full Time Pay - Submit - P gave answer for pay.

Participant 9

1. Success

2. Government Function-Police Officers Only - Next - 2002 - Add - Full Time
Employees - Add - State and All Local > Add - DC - Add - Submit > P
said, “I only want it for March.” - back - Submit - back - back - back - Back
to Build-a-Table Main - Geography-DC - Next - 2002 - Add - Full Time
Employees - Add - State and All Local - Add - Police Officers Only > Add -
Submit = Census of Government Employees (link of right) = Payroll 1997 - Data
Processing - back - back - view as excel file > X to close - P said, “looking for
a specific month. | can’t seem to build a table for that. It’s only by year.” = back >
back = back - back - back - back - back - Level of Government - Next >
back - 2002 - Add - Full Time Employees, Full Time Pay - Add - DC - Add
—> Police Officers Only - Add - P said, “It only gives me the year.” - Adobe link
on right = back - Census of Government Employees (link on right) = 2002
Government Employees and Payroll = Survey Content - P said, “I’m just sort of
looking around.” = back = back = back = Census of Government Employees (link
on right) - 2002 Government Employees and Payroll - Survey Content (P is
retracing steps.) = P saw March 2002 at top of page.
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Task 2: What was the total full-time equivalent employment for state government and local
government in Maryland for March 2002?
Eye-tracking Data

Raw Navigation Data
Participant 1
1. Failure
2. Level of Government-State and All Local > Next - 2002 - Add - back - back
- Government Function (scrolled) - Level of Government-State and All Local >
Geography-Maryland - Government Function-Total - Next - 2002 > Add > P
said, “l don’t see a date for March.” - Full Time Employees - Add - State and All
Local > Add - Maryland - Add - Submit - P said, “I don’t see March. 1’d like
to go back and see if I can find March.” - back - Part Time Pay - Remove - P
scrolled through Geography = P said, “It doesn’t give a box for March.”

Participant 2

1. Failure for total employees for state and local governments (separately)

2. Success for TOTAL employees

3. Geography-Maryland - Next - 2002 - Add - Full Time Equivalent > Add -
State and All Local > Add - Total > Add - Submit - P said, “I think | got the
whole year, not just March.” - back - back = back - Back to Build-a-Table Main
- Level of Government-State and All Local = Next - Back to Build-a-Table Main
- Geography-Maryland - Next - 2002 - Add - Full Time Equivalent > Add »>
State and All Local > Add - Total > Add - Submit - excel link > P said she
was going to try the excel link to see if there was more information there.

Participant 3
1. Failure
2. Pread page = Level of Government-State and All Local - Definitions - P said, “I
am a little scared because it says the stat is calculated separately...I didn’t see that on
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3.

the other page. I’m going to try to figure it out.” = back - Example - P said, “I
am wondering how | get to this screen that is in the Example (the second screen)” -
P minimized Example = Geography-MD - Level of Government-State and All
Local = Government Function-Total - Next - 2002 - Add - P said, “What are
‘variables’?” - Full Time Employees - Add - State and All Local > Add All >
Maryland - Add - Submit

P answered 252,771

Participant 4

1.
2.

Failure

Example - Main = P said, “I hit “Main” because | don’t know where | would find
this information.” - Government Finance and Employment Manual - Site Map -
2002 - State Government Data - 2002 - US Summary Table - back - P
selected MD - P answered: 349,497,879

Participant 5

1.
2.

Failure
Main - State Government Only - 2002 - Maryland - P gave State data only.

Participant 6

1.
2.
3.

Failure for total employees for state and local governments (separately)

Success for TOTAL employees

Geography-Maryland = Next - 2002 - Add - Full Time Equivalent > Add -
State and All Local > Add - Total > Add - Submit - P said, “There is no
information for month...I wonder if the PDF or Excel has more information.”

Participant 7

1.
2.
3.

Failure for total employees for state and local governments (separately)

Success for TOTAL employees

Level of Government-State and All Local = Next - P said, “I don’t see a month so
that might be problematic.” - Full Time Equivalent > Add - Maryland > Add ->
P said, “I don’t know if I need a government function because it didn’t ask for one. “
- Total > Add - Submit = P said, “It gives a number but I am concerned because
it asks for a certain month...if survey was conducted in March, then this is my
answer, but | didn’t see anything about March.” - back - back - back - back >
back = back - Main - State and Local Government-Public Employment and
Payroll - 2002 - Maryland - P said, “Again, | am getting these numbers but | am
not seeing the month. So I will go with the number I got the first time.”

Participant 8

1.
2.
3.

Failure for total employees for state and local governments (separately)
Success for TOTAL employees

P said, “I kind of like this Geography link. It’s easier if | know what state I’m
looking for.” - Geography-Maryland - Next - 2002 - Add - Full Time
Equivalent > Add -> State and All Local > Add - Total > Add - Submit
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Participant 9
1. Failure for total employees for state and local governments (separately)
2. Success for TOTAL employees
3. Level of Government-State and All Local - Next - 2002 - Add - Full Time
Employees > Add - Maryland - Add - Total - Submit
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Task 3: Among California, New York or Texas, which state had the most state public
welfare full-time employees in 19977
Eye-tracking Data

Raw Navigation Data
Participant 1
1. Success
2. Geography-California = Next = back - Next - back - Geography-New York -
Geography-Texas - P said, “Let’s go with California first. | have to look at all
three.” = Geography-California = Next - 2007 - Add - Full Time Employees -
Add - State - Add - Public Welfare - Add - Submit - P gives answer for
California = back = clicked on 1997, but not Add - Submit - back - 2007 -
Remove - 1997 - Add - Submit - P gave new answer for California - back -
back - State > Remove - State > Add All - State and All Local > Remove ->
All Local > Remove - Back to Build-a-Table Main - P said, “I had to go back to
the original table. I have a total for California. | have to test it against New York. |
have to start again with the same criteria for New York.” - Geography-New York—->
Next 21997 - Add - Part Time Employees - Add > State > Add - Part Time
Employees - Remove - Full Time Employees - Add - Public Welfare > Add
-> Submit - P gave answer for New York = P said, “I have to start over for Texas.”
- Back to Build-a-Table Main - Geography-Texas > Next - 1997 - Add - Full
Time Employees - Add - State > Add - Public Welfare - Add - Submit > P
gave answer for Texas

Participant 2
1. Success
2. Geography-California > Next > 1997 - Add - Full Time Employees - Add ->
State - Add - Public Welfare > Add - Submit - P gives answer for California,
and opened as excel = P said, “I will open it in excel so | can remember the info.” >
Start Over > Geography-New York—> Next -1997 - Add - Full Time Employees
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- Add - State - Add - Public Welfare - Add - Submit - P gives answer for
New York, and opened as excel - Start Over > Geography-Texas—> Next -1997
- Add - Full Time Employees - Add - State - Add - Public Welfare - Add
-> Submit - P gives answer for Texas, and opened as excel

Participant 3

1. Failure

2. P scrolled to “helpful Census Bureau links on the bottom.” - Subjects Ato Z > F >
P was looking for full time employees = S = P was looking for state public welfare
full time employees - E = P was looking for employees - Employment and
Payroll (under E) - State and Local Government data = 1997 - P selected
California - P gave answer for CA - back - P selected TX - P gave answer for
TX = back = P selected NY - Answer: CA

Participant 4

1. Success

2. Geography-California - P said, “Can I do control? | wonder if you can do that.” >
P tried to use control key to select more than one state but could not. > Next > 1997
- Add - Full Time Employees - Add - State (but didn’t add) - P said, “What is
public welfare?” - Submit - red error message appeared - State > Add - Submit
—> P read answer for New York - back - back = back - back - back - Main >
P said, “not what | want. | expected Build a Table Main” - back - P said, “Can |
currently select something else? Go to another state?” - Main - back - Site Map
- back - P said, “Wow. | don’t know how to get back so I can find California.” >
Back to Build-a-Table Main - Geography-California = 1997 - Add - Full Time
Employees - Add - State > Add - Public Welfare > Add - Submit - P read
answer for CA. - Start over - Geography-Texas = Next 2 1997 - Add - Full
Time Employees - Add - State > Add - Public Welfare > Add - Submit > P
read answer for Texas.

Participant 5
1. Success
2. Main - P said, “I am going to read very carefully.” - General Info-Public
Employment and Payroll = State Government Data - 1997 - California = P read
answer for California = back - New York - P read answer for CA - back >
Texas - P read answer for TX.

Participant 6

1. Success

2. Geography-US Total - Next - P said, “l am expecting an option with different
states and | could select those states. | don’t want a screen with 50 states but | don’t
know that there is another option.” - back - P said, “Geography makes the most
sense.” - Level of Government-State - Next - 1997 - Add - Full Time
Employees - Add - California, New York, Texas - Add - P said, “it would be
easier if it was a drop-down...it would be high-lighted and you could type the
beginning and it would jump to it.” = Public Welfare - Submit
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Participant 7
1. Success
2. Level of Government-State - Next - 1997 - Add - Full Time Employees - Add
- California, New York, Texas = Add = Public Welfare = Add = Submit

Participant 8
1. Success
2. Geography - P said, “Oh no, that won’t work because | can only select one.” >
Main = 1997 - State Government Data - 1997 - California = back > New
York = back - Texas

Participant 9
1. Success
2. Geography - Government Function-Public Welfare - Next = 1997 - Add - Full
Time Employees - Add - State - Add - California > Add - P typed N- it
didn’t move. P said, “It would be helpful to hit N and it would go to New York.” >
New York - Add - Texas = Add - Public Welfare - Add - Submit
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Task 4: Did Oregon have more hospital employees in 1997 or 2002?
Eye-tracking Data

Raw Navigation Data
Participant 1
1. Success
2. Geography-Oregon - Next = 1997 > Add - Total Employees - Add - State >
Add - Hospitals > Add - Submit - P gave answer for 1997 - Back to Build-a-
Table Main - Geography-Oregon = Next = 2002 - Add - Total Employees >
Add - State - Add -> Hospitals = Add - Submit - P gave answer for 2002

Participant 2
1. Success
2. Geography-Oregon - Next - 1997 > Add - Total Employees - Add - State
and All Local = Add - Hospitals = Add - Submit = P gave answer for 1997, and
opened as excel - Start over - Geography-Oregon - Next - 2002 > Add -
Total Employees - Add - State and All Local - Add - Hospitals > Add -
Submit = P gave answer for 2002, and opened as excel

Participant 3
1. Failure
2. Level of Government-State and All Local - Geography-Oregon - Government-
Total = Next = 1997 = Add - Total Employees - Add - State and All Local,
State, All Local (P used control key to select all options) - Add - Oregon - Add
- Submit = back = 1997 - Remove - 2002 - Add - Submit - P answered
2002

Participant 4
1. Success
2. Government Function-Hospitals = Next - 1997 - Add - 2002 - Add - Total
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Employees - Add - P said, “I like this...only because | can actually think back.” -
State > Add - Oregon > Add - Submit - P said, “I feel so accomplished.”

Participant 5
1. Failure
2. Main - State Government Only-Public Employment and Payroll - 2002 - Oregon
- back = back - 1997 - Oregon

Participant 6
1. Success
2. Geography-Oregon - Next - 1997, 2002 - Add - Add All - State > Add -
Hospitals > Add = Submit

Participant 7
1. Success
2. Level of government-State - Next - 1997, 2002 - Add - Total Employees >
Add - Oregon - Add - Hospitals > Add - Submit

Participant 8
1. Success
2. Geography-Oregon - Next - 1997, 2002 - Add - Total Employees - Add -
State and All Local - Add - Hospitals > Add = Submit

Participant 9

1. Success

2. Site Map - Main - Build-a-Table - Site Map - 1997 - Individual State
Descriptions from 2007 Census of Governments - back - back - 1997 Data Files
—> Public Employment and Payroll = Volume 3, Number 2 Compendium of Public
Employment - P said, “I didn’t think hospitals would be under governments. | have
no idea what or where this would be.” = P looked in table of contents and scrolled.
P wrote answers for 2002. - X to close = back - back - 1997 - back - 1997
Data Files > Volume 1, Government Organization - P looked in table of contents
and scrolled. - P said, “Shoot, | didn’t look to see if it was Oregon...don’t think that
this is what | want.” - TA prompted P back to Build-a-Table Main page =
Geography-Oregon > P said, “I didn’t see the little Next button.” > Next - 1997,
2002 - Add - Total Employees - Add - State and All Local > Add - Hospitals
- Add All - Submit
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Task 5: Create any table and download it to an excel file.
Eye-tracking Data

Raw Navigation Data
Participant 1
1. Success
2. Government Functions-Libraries > Geography-DC - Next - 2007 - Add - Full
Time Employees - Add - All Local > Add - Elementary and Secondary
Instructional Employees - Add - Submit = P says the number is the number of
people who worked for the libraries. P thought he was getting info for libraries, as he
chose Libraries on the Main page (but then over-rode it by choosing Geography) = P
right clicked and downloaded shortcut to desktop = P clicked on Excel, download,
save, open

Participant 2
1. Success
2. Geography-California > Next - 2007 - Add - Full Time Employees - Add -
State - Add - Higher Education Instructional Employees - Add - Submit > P
said, “I am not sure if it is going to give me a table.” - P clicked on Excel, open

Participant 3
1. Success
2. Government Function-Total - Next - 2002 - Add - Full Time Employees >
Add - State and All Local > Add = US Total > Add - Submit = P clicked on
Excel, open

Participant 4
1. Success
2. Main - P said, “I could understand ‘Find a table’ but why would | want to create a
table?” - 2002 - Volume 3. No 1. Employment of Major Local Government > P
scrolled - P said, “I’m just looking for a table.” = P found a table and clicked on
bottom layer (Main site) = P said, “Oh, I clicked on something and it disappeared.”
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- Local Government Directory Survey Forms - back - back = 2002 edition -
Main - P said, “bad site...bad, bad site...pain in the butt...don’t make things so
complicated.” = 2002 edition = 2002 Census of Governments - Census 2002
Brochure - X to close = P said that she was not clear on the instructions and wanted
TA to elaborate. > TA prompted P to go back to Build-a-Table Main page and use it
to make a table = P said she didn’t know how. TA asked P to see if there was
anything there to help make a table. P said, “It says Build a Table but doesn’t say
how to make one.” = Government Function - Next - 2002 - Add - Part Time
Pay - State > MA - Submit - P said, “Wohoah! Did I build a table?!”

Participant 5

1.
2.

Success

Main - back - P said, “I was going to go into Example but I decided to try.” -
back - 1997 edition > County Governments (Downloadable Data File)-> Run,
Next, Finish = P said, “That didn’t do anything. | am clueless.” - Main = General
Information - State Government Data - 2007 - Viewable Data - North Carolina
- P got a table = P said, “I don’t know how to download it to excel.” > TA
prompted P back to the Build-a-Table Main page and asked P to use this page. 2>
Level of Government-State - Next = P highlighted 1997 - P highlighted Total Pay
—> P highlighted North Carolina - P highlighted Total - Submit - red error
message appeared - P went back to each option and added each one. - Submit >
Download to excel, open.

Participant 6

1.
2.

Success
Geography-Florida = Next - P randomly chose things = Submit = Excel, save,
open

Participant 7

1.
2.

Success
Level of Government-State - Next - 2007 - Add - Full Time Employees - Add
- Maryland - Add = Higher Education Instructional Employees - Add - Submit
- Excel

Participant 8

1.
2.

Success

Main - Build-a-Table - Geography-MD > Next - 2007, 2002 - Add - Full
Time Employees - Add - Part Time Employees - State and All Local > Add >
Police Officers Only - Submit - Download to Excel

Participant 9

1.
2.

Success

Level of Government-State and All Local = Next > Add All > Add All (P
highlighted only one, but then hit ‘Add All’) > Remove all = Total Pay - Add All
- Remove All - Total Pay - Add - US Total - Add - Education Total - Add
—> Submit = Excel, save, open
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Task 6: In what month was the 1997 Census of Government Employment mailed?
Eye-tracking Data

Raw Navigation Data
Participant 1

1. Failure

2. Government Function (scroll) = P said, “It doesn’t seem to cover anything that I’m
looking for.” = Level of Government (scroll) = P said, “Not what | am looking for.”
—> Geography (scroll) = P said, “Now I have a problem.” - Level of Government
- Government Function-Other Government Administration = Next - 1997 - Add
—> Full Time Equivalent > Add - US Total - Add - P said, “I’'m
missing...month...” = Back to Build-a-Table Main = Definitions = P said, “l am
going back to the original table because...l don’t see anything that | can break down
into months...looking...to break data down into months or quarters...” = P clicked
on M; nothing happened. = P scrolled through definitions - back - Example ->
Geography = Example opened = P scrolled through; X to close - Geography = P
scrolled - P said, “l don’t see where | can break it down by month. There is not a
timeframe. | can get total...for the whole category, but I can’t break it down.” = TA
asked if P wanted to move on. P worked more. - Government Function-Education
Total > Next - 1997 (didn’t add) - Full Time Equivalent > Add - State and All
Local > Add - US Total > Add - Submit - red error message - Full Time
Equivalent > Add - Submit = red error message

3. P ended task

Participant 2
1. Success
2. Site map = 1997 - back - 1997 - back = 1997 Press Release Public
Employment & Payroll - P read article - 1997 state government employment and
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payroll data link (in article) - P answered

Participant 3

1.
2.

Failure

Government Function-All Other and Unallocable - Next - P said, “That table
doesn’t work.” - Back to Build-a-Table Main = Main = Public Employment and
Payroll-General Information - back - 1997 - P said, “I am trying to find anything
that says when the mail went out.” - back - back - Level of Government >
Geography = Government Function-All Other and Unallocable > Next - Subjects
Ato Z > M - Mail > Subjects Ato Z - D - P said, “I am looking for ‘data’.” >
M - back - back - P responded: August

Participant 4

1.
2.

3.

Failure

Main = 1997 - back - P said, “I’m thinking 1’d rather be a rat in a maze bumping
my head against nothing because that is how I feel doing this. Wow.” = Site map -
Data Files > Main - back - P said, “I don’t even want to look at this thing.”

P ended task.

Participant 5

1.
2.

w

Failure

Main = 1997 edition = P said, “I am looking for Census of Government
Employment.” - Main - P said, “Now | am scrolling and reading everything.” -
Federal Government- Public Employment & Payroll = 1997 - Federal Government
Employment data by governmental function - P looked for “payroll.” - back -
Main = 1997 - P said, “I am going to read a little more carefully...l have a
tendency to not read things carefully.” - Volume 1, Government Organization - P
said, “I am going to glance at this and see if it gives a month...now, | am absolutely
clueless...not seeing anything that tells me about a month.” - P said, “l am
clueless...just looking for a month it was mailed...actually haven’t found Census of
Governments at all.” = X to close Main = State and Local Government (in Public
Employment and Payroll) - Build A Table - Level of Government - Next >
1997 (didn’t add) = Add All > Add All > Add All = Submit - red error message
-> P highlighted Full Time Employees = Submit - red error message > P
highlighted US Total and selected Add All for Date - Submit - red error message
-> P said, “Honestly, | have never been this clueless. This is very difficult to
navigate...maybe because | am not reading carefully...but I am going to give it a
chance.” - P waited a few minutes, and scrolled, read top section of page, and said,
“taking a long time since all the options were chosen...wonder if | can remove all and
justdo ’97. I’ll try that.” > Remove All > Remove All > Remove All > Submit
—> Submit = Nothing happened. - P said, “I think I am going to give up on this
task.”

P ended task.

P attempted the task again at the end of the session: Main - 1997 - P said, “l am
looking for the month.” - P ended task in 47 seconds.
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Participant 6

1. Success

2. Search (at bottom) “when 1997 Census of government employees mailed” - P said,
“Search saves so much time.” > One result appeared, P selected it. > back -
Search “mail date 1997 *census of government employment’ = no results = Search
#1997 ‘census of government employment’” - P chose second option - P chose
first option: Census of Government Employment = P said, “I can’t maximize or
minimize the size of the window, which is annoying.” - Data Collection

Participant 7

1. Success

2. Main - P said, “I am not looking for numbers but the month it was mailed. My
thought is that it would be on a publication. = 1997 - P said, “It might be March,
but it doesn’t say mailed, so let me keep looking.” - P said, “I would call the 800
number and look while I am on hold.” = back - Program Overview - Census of
Governments - back - back - Publications (PDFs) = Additional information on
Government reports (on bottom) - M (for mail) = Mail response rate (1990 Census)
- P said, “Maybe it is the 1990°s.” - back - back - back - 1997 - P said,
“March, but I am not confident.”

Participant 8

1. Success

2. P said, “I am looking on the first page, but it doesn’t say when it was mailed out.” -
Main - 1997 - P said, “I am looking for something with a date so | don’t have to
read all of this.” - back - back - P said, “ I would think March because it says
‘data for the month of March,” but when was it mailed?” - Main - Press Releases
- back > 1997 - P said, “I see the month they are reporting, but not when they
mailed it...I would say March...That’s all | see.”

Participant 9

1. Failure

2. Government Function-Total - Definitions - back - Level of Government-State
and All Local = Government Function - Geography-US Total > Next > 1997 -
Add All - P scrolled through Government Function, and said, “I don’t know where |
would find this at all.” - Remove All > 1997 &> Add - Add All > Add All >
Submit = back - back - back = back - back - Site Map - 1997 - P said,
“Why do I get 2002 when I click on 1997?” - back - Site Map - 1997 Data Files
- Volume 1, Government Organization = P said, “I am looking for when it was
mailed.” - P looked at table of contents and looked to back cover. P answered
August.
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Task 7: What was the response rate to the Census of Government Employment for county
governments in 2002?

Eye-tracking Data

Raw Navigation Data
Participant 1

1. Failure

2. Government Function = P said, “I am looking for the response rate for employment.”
- Level of Government-All Local > Geography - Level of Government ->
Geography-US Total = Level of Government-Local - Next - 2002 &> Add -
Total Employees - Add - P scrolled through Geography and Government Function
- Government Function-Other Government Administration > Add - P said, “l am
looking for something that denotes employment.” - Higher Education Instructional
Employees - Add - Elementary and Secondary Instructional Employees - Add =
Hospitals > Add - Social Insurance Administration - Add - Submit - red error
message appeared - Hospitals > Remove - Elementary and Secondary
Instructional Employees - Remove - Higher Education Instructional Employees -
Remove - Other Government Administration - Remove = Higher Education >
Add - Social Insurance - Remove - Submit - red error message appeared - P
said, “What I am looking for, | am not finding. It doesn’t tell me what | need to
know.” = Full Time Equivalent > Add - US Total > Add - Submit - back - P
said, “I built a table, but I’m not sure I built it for the right criteria.” = TA asked if P
wanted to move on. P wanted to continue working. = Level of Government > All
Local = Government Function-All Other Higher Education = Geography-US Total
- Next - 2002 - Add - Full Time Employees - Add - All Local > Add »>
Government Function-Other Government Administration = P chose other options
and added - Submit - P said, “I don’t know how to factor it.”

3. TA ended task.
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Participant 2

1.
2.

Failure

P said, “I am reading the three different categories of data to figure out which one to
click on.” - Level of Government-All Local - Next - P said, “I am scrolling
down...not sure what to select...looking for government function box, if there is any
option for county there.” > back - Level of Government-All Local - Next - 2002
- Add - US Total > Add - Total - Add - Submit - red error message
appeared - Total Employees - Add - Submit - P gave answer: 13,389,169

Participant 3

1.
2.

Failure

Government Function- scrolled through = P said, “I am looking for the response rate
to Census of Government Employment.” - Total > Next - 2002 - Add - Total
Employees - Add - State and All Local > Add - US Total > Add - Submit >
P answered 18,463,863

Participant 4

1.
2.

3.

Failure

Level of Government = P said, “I am not seeing where | would get that information
at all. 1 would think ‘county’” would be in level of government but it’s not
there...none of these look like they would give me the answer.”

P ended task.

Participant 5

1.
2.

Failure

Main - Summary Reports - Preliminary Report 1 - P said, “I am looking for
response rate...for a table or a graph...It will keep me from reading everything.” > P
guessed 87,900.

Participant 6

1.
2.

Success

Level of Government-All Local - Next - 2002 > Add - Add All > US Total >
Add - P scrolled through Government Function and said, “None of those seem to
work.” = back = back = back - P used arrow button next to back button to
navigate to Build-a-Table Main page - Government Function - P said, “l have no
idea how to find county governments.” = Search (at bottom) “response rate country”
-> Search “census of government employment” - Search “census of government
employment 2002” - P chose second option = P chose second option- 2002 Census
of Government Employment - Data Quality

Participant 7
1. Failure
2. Psaid, “I am trying to figure out the variable | need to focus on...seems like county

governments, but | don’t see county, | see other words that relate to it in level of
government...not exactly sure where to go. Maybe they are interchangeable and you
can find the same answer...I wonder if Census of Government Employees is a
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survey...going to Main because the answer isn’t at my fingertips.” = Main - 2002
-> P said, “Publications might have response rate.” = P said, “If county is the same
as local then 87,525 is my answer...not 100 percent confident...county and local
government could be the same, but I’m not sure.

In next task, P saw “county’ in level of government on Main page; said he’d go to this
page to work on it.

Participant 8
1. Failure
2. Main = back = Level of Government-All Local 2 Next = 2002 - Add = Add

All - Add All - Total > Add - Submit > P expected to see the total number of

employees for all of the option and that would tell P how many responded. - back -
Main - 2002 List of Governments > County Governments

Participant 9

1.
2.

Success

Level of Government-Local - Next - 2002 - Add All = US Total > Add All >
Total > Add - Submit - Census of Government Employees and Payroll - Data
Quality = Response Rate and Non-Sampling Errors
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Task 8: Locate a copy of the 2007 Municipalities, Counties, Townships survey, which is also
called the E-4 survey form.
Eye-tracking Data

Raw Navigation Data
Participant 1
1. Success
2. Level of Government-All Local = Government Function-Other Government
Function > Geography-US Total - Level of Government - Government Function
- Next - 2007 - Add - Main - 2007 - Local Government Only - P said, “I
am looking for anything that denotes an E4 survey.” - downloadable data = back
-> survey content > E4

Participant 2

1. Failure

2. P said, “I am looking at the home page to see if it has any information about that
form.” - Site map - 2007 - 2007 Census of Governments - Directory Survey of
Special Districts (G-30) - X to close = back - 2007 State and Local Government
- Viewable Data = back - Main - back - back = back - back = back to
Build-a-Table Main - Definitions - back - Search - P typed, “e-4” > Go > P
said, “a lot of results...I don’t think that’s what | need.” - back - back = Site map
- 2007 - Local Governments and Public School Systems by Type and State: 2007
Excel link = P said, “I am wondering if this is the form | am looking for.”

3. TA ended task.

Participant 3
1. Failure
2. Subjects A to Z > back - Example - X to close = Level of Government-Local >
Geography-US Total - Government Function - P said, “l want to go back. | don’t
think I am going the right way.” - Subjects A to Z - Z - P looked for E4 and said,
“l thought numbers might come after z.” - back - back - Example - Definitions
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- back = Level of Government-All Local - Geography-US Total > Government
Function-Libraries = Main - Quality (at bottom of page) > TA asked what P was
expecting to find and P was expecting a survey. - Contact Us

3. TA ended task.

Participant 4
1. Success
2. Level of Government > Geography > Government Function - Geography - Level
of Government-State and All Local - P said, “Aigh...brother.” - Next - 2007 -
Add -> Submit = red error message appeared - back - Next - 2007 - Add > P
said, “I’m looking for ‘surveys’ in government functions. | don’t think I am going to
find it here.” > Main - Survey Forms - E4

Participant 5
1. Success
2. Main - Survey Forms - 2007 Census of Government G30 form - X to close =
E4-FY2007

Participant 6

1. Success

2. P said, “I am scanning to see if anything clicks...looking for a survey form in
2007...going with level of government since it says municipalities and townships =
level of government-State and All Local = Next = 2007 > Add - All > Add > P
said, “None of this has forms.” - Back to Build-a-Table Main - P said, “At this
point, | would go to Google and do a search for this form.” P asked if there was any
other place on the site that P could try rather than going to Google. - Catalog (on
bottom) - back - P said, “I am looking to see if there is anything that strikes me
where it could be.” - Search (at bottom) - P typed “e-4 survey form” - P chose
first option - e-4-FY2007

Participant 7
1. Success
2. Level of Government-All Local - Nest = 2007 - P said, “I am just looking for a
form. 1 don’t think I need a table. Maybe it was on the front page and | was looking
over it.” - back - back - P said, “I don’t see why | would have to Build A Table
to get a survey; | should be able to get it from clicking on links.” - Main - Survey
Forms = E4 FY 2007

Participant 8
1. Success
2. Main - Survey Forms - E4 FY2007

Participant 9
1. Failure

2. Level of Government-State and All Local = Next = 2007 - Add - P said, “I’'m

not sure, | don’t really have anything else.” - Add All > Total - Submit - red
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error message appeared - back - back - back - back - Definitions = back -
Site Map - 2007 - 2007 Census of Governments - Directory Survey of Special
Districts (G-30) - X to close = Back - Governments Integrated Directory (GID)
- On-Line Query System -> back - back - P said, “There’s no Search bar.” >
Search (at bottom) “e4 survey form” - P chose first option - page 2 > page 3 > P
chose first option - Statistical Abstract - back - back - back - back - back >
back = P said, “I thought Search might help, but...” - Subjects AtoZ>E > F >
back - back - 2007 State Government - US Total - back - Main - 2007
edition of Governments Integrated Directory (GID) - View Results - X to close
winzip screen > Main - Site Map - 2007 - Viewable Data - US Summary
Table

3. P ended task
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